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Executive Summary  
 

The purpose of this Intellectual Output is to assess and evaluate all the factors affecting the 

feasibility of the training online platform which will be developed in next phase.  

More specifically, within this deliverable an analysis and evaluation of the proposed platform 

will be performed to determine (1) how it is best technically feasible, (2) what the best 

outcome within the estimated cost can be and (3) how to ensure its viability through 

exploitation.  

The training Platform will be developed as a core intellectual output (IO4) of the project EXTRO 

SKILLS. The creation of the online training platform, which will address the most important 

challenges faced by staff, work in export departments of the fashion sector, as reflected in the 

primary research which conducted by the project partners in national level (IO5), aims to 

support the development of the fashion sector and contributes to dealing with skill gaps and 

mismatches in the sector. Specifically, the designed training platform will incorporate the 

research findings on the issues and needs of each partner regarding skill gaps and mismatches 

in EU level.  

The scope of this document is to report on the system validation and propose the future pilot 

operation process. More specifically, it aims to report all issues, remedial actions, pilot 

incidents and how they were addressed, as well as lessons learnt. Towards this end, the 

current deliverable is broken down into two main sections.  

The first main section contains the preparatory system validation methodology, which aims 

to document the process to be followed in order to deliver the final version of the EXTRO 

SKILLS platform, passing through various iteration until it becomes solid enough to be 

delivered to the end users and be evaluated by them.  

The second main section contains the analysis of the chosen Learning Management System 

software. The main deviation from the initial methodology was the introduction of additional 

steps and the complete restructuring of the platform, in order to produce a version of the 

platform stripped down in terms of technical functionalities, but with significantly enhanced 

usability and user friendliness. Towards this end, the main lesson learnt was that technology 

is a priceless facilitator of increased potential, but that could come at the cost of user 

friendliness and usability, which seems to be especially.  
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Introduction  
 

Fashion industries need a flexible workforce that can respond to the development and the 

globalized market and the trend and need for internationalization. The workforce needs to be 

well qualified and ready to face the increased competition and rapid technological changes. 

To be compete in the global market fashion industries have to be smarter and able to adapt 

to changes. To achieve this, fashion industries need new education and training systems and 

tools for their existing and potential workforce in order to respond to the demands of the 

labour market and the global competition. In a framework of global competition, innovation 

and development are crucial elements to provide fresh impetus to a sustainable and 

competitive industry. 

The staff working in the export departments consists a crucial entry point for supporting the 

fashion sector, given their role and influence in the value chain. The designed platform will be 

a technology and data - driven market place to facilitate access to data related to international 

markets, visibility, finance, mentorship and training. But in order to deliver the online training 

platform, there is a need to understand the fashion industry from the perspective of the 

different players i.e. exports, suppliers, buyers, retailers and financiers. From this end this 

platform will contribute also to undertake a market study with the aim of developing an online 

interactive market place for EU MSMEs in the textile and fashion industry.  

The online training platform will specifically look at the fashion sector as an important 

contributor to economic growth and job creation in Europe. The platform will focus on online 

training and will facilitate dissemination of knowledge and sharing of experience. Moreover, 

it will serve as a medium for all stakeholders in the field to share concerns and advice, as well 

as promote employment opportunities. This platform will be served as a high-quality ICT Tool 

for MSMEs and will contribute to: 

 Improve and extent of high quality learning opportunities tailored to the needs of 

export and fashion marketing personnel 

 Define a professional profile for the exports and fashion marketing experts 

Studies have demonstrated that the use of digital platforms can increase trainees’ /users’ 

performance. Because the end users (trainees, staff etc) are more engaged, get immediate 

feedback and are easily able to build a foundation of knowledge, they become better able to 

learn and retain new concepts. Adaptive learning technology, an innovative component to 
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learning platforms, is able to individualize lessons to assess the students’ knowledge and assist 

them with concepts they need help with. 

Thus, in this feasibility study we will check if Moodle is a viable alternative as a software 

management learning system for our platform in areas of functionality, usability, and total 

cost of ownership.  

 

Best Software Management Learning System  

The best learning system solution is defined in this study as one in which the following 

components are considered that sufficiently met: 

• Interoperability and Flexibility 

• Cost effectiveness 

• Support and Training 

• Ease of Use 

• Scalability 

• Sustainability 

Interoperability is defined as the ability of the Moodle system to integrate with related 

peripheral applications and services (mobile apps), which is a critical component for planning 

future learning technology solutions. Flexibility is the ability to (1) easily move learning 

content in and out of the system and the ability to (2) customize applications to meet specific 

needs of end users and MSMEs.  

Cost effectiveness is defined as the total value of return on investment of the Training 

Platform’s System to deliver core functionality and usability with consideration of the total 

financial burden of evaluation; procurement; pilot testing; roll-out; staff training and support; 

and coordination of primary and secondary learning technologies that impact specific learning 

needs. 

Support and training enables Associations, Training Centers and MSMEs to be responsive to 

emerging technologies which enhance platform’s utilization. Continual improvement through 

training and access to 24/7 support are two contributing factors for ensuring success. 
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Platform’s ease of use includes development of intuitive platforms (1) requiring a minimum 

of orientation and training, (2) providing uniform access protocol to multiple applications, and 

(3) minimizing support and maintenance requirements. Ease of use is a major factor of success 

in online education. End users’ training and pilot activities considers natural partners of 

support services. 

Scalability is defined as the ability of the platform to efficiently serve both large and small 

institutions with agile hardware/software solutions at the macro and micro levels. 

Sustainability is the ability to maintain a consistent level of learning infrastructure and 

support required to (1) meet the growing enrollment demands of students, (2) meet growing 

infrastructure needs, and (3) address limitations of funding, faculty training, and support staff 

now and into the future.  
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Glossary 
 

AAM Authorware Shocked file (Adobe) 

AIFF Audio Interchange File Format 

ASF Advanced Streaming Format (Compressed Windows audio/video) 

AU Sound (audio) file 

AVI Audio Video Interleaved animation file 

CSS Cascading Style Sheet 

CSV Comma Separated Values text file format (ASCII) 

DOC, DOCX Document; Office Open XML Text document 

GIF Graphics Interchange Format (bitmapped graphics) 

HTM, HTML Hypertext Markup Language 

JPG,JPEG Joint Photographic Experts Group (graphics file) 

JIF JPEG File Interchange Format 

LMS Learning Management System 

MPE, MPG, 

MPEG Multimedia container format, video, audio 

MOOV, MOV Movie file 

ODT Open Document Text 

PDF Portable Document Format 

PPS PowerPoint Slideshow 

PPT, PPTX MS Office Open-XML Presentation 

QT QuickTime movie 

RA Remote Access file 
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RAM RealAudio file 

RTF Rich Text Format 

SWA Shockwave Audio file (Audio) 

SWF Shockwave Flash 

TIFF Tagged Image Format File 

TXT ASCII text file 

WAV Sound format (Windows) 

WMA Windows Media Audio file 

WMF Windows MetaFile (vector graphics) 

WMV Windows Media Video file 

WPD Windows Printer Driver 

XLS, XLSX Excel Spreadsheet 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   9 
 

1. Formulating the Digital Training Platform  

1.1. Basic Functions  
 

The envisaged Platform will act as a portal, where an innovative curricula with courses 

together with international exports information can be found and exploited, retrieved and 

queried using modern ICT technologies. In reality, it is a virtual entity, created through 

harmonized information. Indeed, the Platform will go beyond a courses provider and pure 

data sharing platform: it will also involve the way information and data are displayed, 

examined, and compared.  

The courses and information that will be included in the Platform will cover all the aspects 

related to fashion sector’s export activity based on the also on the results of IO5: not only 

underground data but also information on the economics, regulations, national and EU 

policies, market demand, market requests, and intellectual property issues etc. All these 

issues represent the concept of export’s manager knowledge, as outlined in the following 

Figure. 
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Figure 1: The four topics covered in the information list that represent geothermal 

knowledge. 

 

 

The platform would not be limited to provide the training curricula for export’s staff and 

statistically accessing and organizing information: the Platform’s structure will also 

aggregate and compare information. To be able to conduct brief surveys on fashion 

sector’s exports knowledge, Platform’s tools have to ensure, for example, browsing from 

a catalogue to a document and from a document to a table etc (see Figure 2). 

The platform will make it possible not only to browse or query statistical data about 

exports but also to obtain information in various aggregate forms such as charts, reports 

or tables that enable the information available in its database to be quickly surveyed and 
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compared. Finally, through a catalogue tool (i.e., a search system based on keywords, 

countries and categories), the proposed Platform provides all the electronic documents 

of interest. 

 

Figure 2: EXTRO SKILLS Platform functionalities 

 

 

1.2. Review of the best solution technical elements  
 

The EXTRO SKILLS multilingual digital training platform will be a free learning resource 

where upon registration the user will have access to tools that will afford them access to: 

 collaborative determination of subjects using wikis 

 the exchange of professional experiences and opinions using blogs 

 improve their competences through e-learning 

 modules specifically designed for exports’ departments staff 

 discussions on relevant topics in the online community forums 

 the ability to contact peers instantly and directly through chat or sending direct 

personal messages from within the platform 

EXTRO SKILLS DIGITAL PLATFORM - FUNCTIONALITY 

Statistical
Data

Training
Courses

Reports

Plots

Catalogue Documents
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 examples of good practice in the field of fashion exports 

 browse or query statistical data about exports and obtain information in various 

aggregate forms such as charts, reports etc 

 

In order to further proceed with the selection of the best technical solution for the 

development of the EXTRO SKILLS digital training platform we have to determine our learning 

and development objectives in advance. 

What are the core learning and development objectives and aims? Which skill sets or 

information is our target group expecting to take away from our eLearning courses? Before 

we even begin to explore our LMS options, we must to have a clear sense of what we want to 

achieve when utilizing that LMS. This will lead us to choose the LMS that will meet our target 

group’s learning and development needs. 

Also, we should assess and review the learning and training needs on exports’ according to 

the results of the survey took place in each partner’s country and from EURATEX in 4 more EU 

countries. Go through the survey we see what needs to be improved upon and what is working 

effectively. Doing so, we will have the chance to select an LMS that utilizes the successful 

learning materials we currently have, while fine-tuning the ones that do not support and 

promote our training objectives. 

In order to assess any technical considerations or limitations, when choosing a LMS, we also 

evaluate how the new learning system will be integrated with our current technologies or 

software. We will also consider how we want our target group to access the information. Will 

they be using their mobile devices? The answer is yes, so then we will find a LMS that supports 

mobile platforms too. 

With the wide variety of LMS features that are available today, it can be challenging to narrow 

down our list of must-haves for our EXTRO SKILLS digital training platform. However, it's 

important to have a clearly defined set of features and functions that our LMS absolutely 

needs to have in order to be a good return on investment. For example, it has to be mobile 

friendly and it has to include content reusability features.  

Moreover, we have to consider adaptability and maintenance as the keys to ensure the future 

success of a LMS. A LMS may meet all of our requirements in regards to features and technical 

specifications, but we will also have to think about our LMS in the long-term. Is the LMS easy 
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to maintain if we need to update our Platform on a regular basis? In this context, we have also 

to consider the data tracking capabilities of the LMS. While the development and design 

capabilities of our LMS are important, we won't be able to create the best possible eLearning 

experience without tracking features. Ideally, we need a LMS that offers data tracking, so that 

we can gauge learner performance and determine if any areas of our eLearning courses need 

to be fine tuned. 

Last but not least we have to review the experience and background of the LMS vendors. We 

will search the internet and look online to find if there are any reviews for the LMS and 

company, or ratings that will give us a better idea of how they dealt with customers.  

Based on all the above elements of the architecture and technical requirements for our EXTRO 

SKILLS digital training platform we will search for the best Learning Management System that 

will allow us to avoid costly trial and error.  

 

1.3. Learning Management System choice  
 

A Learning Management System is an essential tool for eLearning professionals. There are a 

variety of different open source Learning Management Systems that can offer the dynamic 

and flexible eLearning platform we need. We search the internet and find the basic features 

and reviews for the top 8 open source LMS solutions we decided to consider. 

Moodle 

Moodle is one of the most popular open source LMS options available today. It features 

dashboards, learner tracking, and multimedia support. This open source Learning 

Management System gives the ability to create mobile-friendly online courses and integrate 

third party add-ons. One of the standouts of this tool is the user community. Unlike many 

other open source LMS solutions, in Moodle there is the option to get answers to pressing 

questions almost immediately by accessing the online support database, and download pre-

made eLearning courses that can save time and trouble of creating them from scratch. It’s 

worth mentioning that Moodle may be a bit more complicated for new users, but mastering 

the tool is well worth it if we are looking for a total design freedom. 
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ATutor 

This open source Learning Management System boasts a variety of useful features, ranging 

from email notifications to file storage. One of the most notable highlights of ATutor is that it 

is user-friendly and easily accessible, which makes it an ideal match for those who may be new 

to the world of eLearning design and development. It also offers a wide selection of themes 

to speed up the eLearning course development process, as well as eLearning assessment tools, 

file backups, analytics, and poll integration. 

Eliademy 

This open source Learning Management System is completely free for educators and 

eLearning facilitators, but a small fee per user is charged for the Premium version. It features 

eLearning course catalogs, eLearning assessment tools, and even a mobile Android 

applications for educators who wish to develop mobile learning modules for their on-the-go 

audiences. ELearning facilitators can simply upload and share the eLearning course with their 

audience immediately, as long as the learners have shared their email addresses. 

Forma LMS 

From skill gap analysis to detailed analytics and reporting, Forma LMS is packed with variety 

of features. It also boasts certificates, competency management support, and a wide range of 

virtual classroom management tools, including calendars and event managers. This open 

source Learning Management System is ideally suited for corporate training programs and 

offers an active online community where you can find advice, tips, and tricks to get the most 

out of the open source tool. 

Dokeos 

If you’re looking for pre-built eLearning course elements, then Dokeos may be the best open 

source LMS option that is offered for free up to 5 users. It features a variety of eLearning 

templates and eLearning course authoring tools that you can use to create rapid eLearning. 

Their website also features a wealth of useful information, including video tutorials that walk 

you through every step of the process. The interface is user-friendly and intuitive, which 

makes it a perfect match for newer eLearning professionals or those who don’t want to go 

through a steep learning curve. 
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ILIAS 

This open source Learning Management System holds the distinction of being the first open 

source LMS that is SCORM 1.2 and SCORM 2004 compliant. It’s flexible, versatile, and scalable. 

In fact, ILIAS is one of the few LMS tools that also doubles as a full-fledged collaborative 

eLearning platform, as you can communicate with your team and share documents all in one 

place. It’s absolutely free of charge for all eLearning developers and organizations, as well as 

educational institutions, regardless of the number of users. If you have hundreds, or even 

thousands of users, this can save you a bundle, as many paid LMS options charge by user. 

Opigno 

Opigno does not disappoint when it comes to features. Certificates, class calendars, online 

forums, eLearning authoring tools, eLearning assessments, and video galleries are just some 

of the highlights. This open source Learning Management System is based on Drupal. Thus, 

you have the ability to manage your virtual training program, track learner skill development, 

and integrate e-commerce using just one tool. Opigno also offers online surveys, instant 

messaging, and chat, which makes it a great feedback and collaboration tool. 

OLAT 

ELearning assessment tools, social learning integration, and learner home pages are just some 

of the things that set OLAT apart from many of the other open source LMS solutions. You will 

also find a class calendar, email notifications, eLearning course bookmarks, file storage, and 

certificates in this open source Learning Management System. OLAT makes it simple and 

straightforward to add users and groups to eLearning courses, as well as develop 

comprehensive eLearning course catalogs. Another notable highlight is its browser check 

features, which gives you the opportunity to test eLearning courses on a wide range of 

browsers to make sure it is compatible. This is ideal for multi-platform eLearning courses that 

need to run on a variety of different devices. 

Open source Learning Management Systems can offer the opportunity to create and deploy 

eLearning courses, especially if we are willing to take the time to master all of its features. In 

some cases, an open source LMS may come with a learning curve, but the cost-savings and 

design freedom may be well worth it in the end.  

 

 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   16 
 

2. Exploitation of the skills needs survey findings   

2.1 Background  
 

In the frame of the project a Study for detecting and identifying exports’ staff skills needs and 

the existing gaps in EU MSMEs, took place at the same time in all partner countries thus 

Greece, Spain, Romania and the UK. Also, PP EURATEX, conduct the survey in additional 8 of 

its members – associations countries thus in Belgium, Portugal, Hungary, Bulgaria, France, 

Italy, Lithuania and Croatia. So, the survey has conducted in total 12 EU countries. 

For the survey’s purposes the partnership designed a questionnaire which structured on the 

project needs for findings. The questions related to three core main areas: 

 Profile of the companies  

 Exports’ experience and knowledge for the exports profile of the sector in each 

country  

 Identification of skill needs and gaps  

The survey lasts from March till August 2016. In order to achieve reliable results, it is asked 

for each partner to collect 20 questionnaires from its companies – members. Partner EURATEX 

collects 37 questionnaires they conduct the survey to 8 different countries. In following 

paragraphs, we will review the main findings of the research which will be used as the base 

for the selection of the proper LMS for the EXTRO SKILLS digital platform development.  

The data was also analyzed in two ways: 

Qualitative analysis: making a thorough analysis and cross-checking of the questionnaire 

responses and related comments, in order to draw a reliable and accurate picture or “profile” 

for each country, and allowing in-depth country comparisons for selected key items. 

Quantitative analysis: using statistical methods to identify patterns, correlations and rankings 

of countries, the relationship between export activities, the size of the company and the skill 

needs and their opinion about e- learning and use of a digital training platform. 

In the following paragraphs a description and presentation of the core statistical findings that 

used for the selection of the proper technical solution – Learning Management System 

software for the development of the EXTRO SKILLS digital training platform, will be shown.  
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2.2 Core Statistical Findings  
 

In this paragraph the core statistical findings resulted from the EU survey took place in the 

frame of the project EXTRO SKILLS, will be presented. As mentioned before, the results of the 

survey will be used both for the development of the training courses – curricula but also for 

the proper selection of the best Learning Management System which will be used for the 

development of the EXTRO SKILLS digital training platform on which will be properly adapted 

the development of the online training courses. The core statistical findings will be presented 

initially by country and then core findings will be presented in the total of the research.  

Greece  

In Greece 20 questionnaires collected from Enterprises – members of the Greek Partner SEPEE 

- from all over Greece. 

The sample is characterized by reliability and accuracy (proper completion of the 

questionnaires – valuable answers in open type questions. 

 The sample 

The sample was constituted by enterprises that all declared 10+ years of operation. The 55% 

of them are Small, 30% medium and 15% Micro (according to SMEs definition), thus there is 

proper representation of the enterprises in the sample.  

 

 

 

 

 

 

 

 

 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   18 
 

           Figure 3: The size of the sample in Greece  

 

 

In Figure 4 we see the distribution of enterprises according their declared activity. As we can 

see the majority of the enterprises participated in the survey in Greece operate in Retail and 

fashion design.  
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  Figure 4:  Activity of the sample in Greece 

 

 Main Findings  

 

 19 out 20 enterprises respond that they have exports experience 

 19,5 years is the average years of experience 

 100% of the sample respond that Retail is their Route to Market 

 11 out of 20 enterprises respond that their Routes to Market are Retail and E-shop 

 19,4 years is the average of exports experience of enterprises respond that they use 

E-shop  

 From the enterprises engaged with E-commerce and exports (e-shop): 1 is Micro, 6 

Small and 4 Medium size  

 32,75% is the average of exports activity in total income 

 40 % of the enterprises respond that they DO NOT know the quantities/values they 

would like to export 

 

 Why are Exports important  

 

 Attract More Customers – 15 out of 20 enterprises (80% of our sample) rank as 

extremely important the attractiveness of more customers  
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 Attract More Customers – Only 4 enterprises rate as very important and 1 enterprise 

as important  

 Lessen Competition – This factor rated low by the enterprises summing mainly rates 

from 1 to 3 

 Seasonal Market – This factor ranked as the less important as it sum up the bigger 

number of 1 rates (11 enterprises) 

 New Business Model – There is a considerable variance in rating of this factor (from 

1 to 5) without important gravity 

 Improve Cash Flow – This is the second most important factor as the 35% of the 

enterprises considered it as extremely important 

 

 

 Self-Evaluation 

The main Fields that enterprises in Greece declare that need help are: 

 Creating an overseas Sales team (70%) 

 Using Embassy/High Commission (65%) 

 Finding Trading Partners (50%) 

 Legal Aspects (40%) 

 

Spain  

In Spain 20 questionnaires collected from Enterprises from all over Spain. 

The sample is characterized by reliability and accuracy (proper completion of the 

questionnaires – valuable answers in open type questions. 

 The sample 

The sample was constituted by enterprises that all declared 10+ years of operation. The 45% 

of them are Small, 25% medium and 20% Micro (according to SMEs definition), thus there is 

proper representation of the enterprises in the sample.  
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           Figure 5: The size of the sample in Spain  

 

 

In Figure 6 we see the distribution of enterprises according their declared activity. As we can 

see the majority of the enterprises participated in the survey in Spain operate in Textile 

Manufacture.  
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           Figure 6:  Activity of the sample in Spain 

 

 Main Findings  

 

 All the enterprises of the sample have exports experience 

 24,65 years is the average years of experience 

 17 out of 20 of the sample respond that other than retail and e-shop is their Route to 

Market 

 Just 5 out of 20 enterprises respond that their Routes to Market is Retail and none of 

them is selling through E-shop 

 52,82% is the average of exports activity in total income 

 

 Why are Exports important  

 

 Attract More Customers – 19 out of 20 enterprises rank as extremely important and 

1 as very important the attractiveness of more customers  

 Lessen Competition – This factor rated in an average of 3,15 by the enterprises  

 Seasonal Market – This factor ranked as the less important as it sum up the bigger 

number of 1 rates (8 enterprises), with an average of 2,15 points  
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 New Business Model – There is a considerable variance in rating of this factor (from 

1 to 5) without important gravity and an average of 3,15 by the enterprises 

 Improve Cash Flow – This is the second most important factor as more of the 50% of 

the enterprises considered it as extremely or very important 

 

 Self-Evaluation 

The main Fields that enterprises in Spain declare that need help are: 

 Intellectual Property Protection (45%) 

 Using Embassy/High Commission (35%) 

 Using Chamber of Commerce (25%) 

 

Romania  

In Romania 20 questionnaires collected from Enterprises from all over Romania. 

The sample is characterized by reliability and accuracy (proper completion of the 

questionnaires – valuable answers in open type questions. 

 The sample 

The sample was constituted by enterprises that 4 of them declared 1-10 years of operation, 

while the rest 16 declared 10+ years of operation. The 45% of them are Medium, 30% Big and 

20% Small (according to SMEs definition), thus there is proper representation of the 

enterprises in the sample.  
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      Figure 7: The size of the sample in Romania  

 

 

 

In Figure 7 we see the distribution of enterprises according their declared activity. As we can 

see the great majority of the enterprises participated in the survey in Romania operate in 

Apparel Manufacture (75%), while the Text Manufacture comes second with 25%.  
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           Figure 8:  Activity of the sample in Romania 

 

 

 Main Findings  

 

 All the enterprises of the sample have exports experience, there is only 1 enterprise 

with no export experience   

 16,12 years is the average years of experience 

 7 out of 20 of the sample respond that other than retail and e-shop is their Route to 

Market 

 Just 4 out of 20 enterprises respond that their Routes to Market is Retail and none of 

them is selling through E-shop 

 74,88% is the average of exports activity in total income 
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 Why are Exports important  

 

 Attract More Customers – 14 out of 20 enterprises rank as extremely important and 

2 as very important the attractiveness of more customers  

 Lessen Competition – This factor rated in an average of 3,46 by the enterprises  

 Seasonal Market – This factor is rated in an average 3,07 by the enterprises and there 

is a variance in its rating (from 1 to 5) without important gravity  

 New Business Model – This factor has also a considerable variance in rating (from 1 

to 5) without important gravity while the average rating by the enterprises is 2,92 

 Improve Cash Flow – This factor is of equal importance with the factor “Attract More 

Customers” as 16 enterprises consider it as extremely or very important and it has the 

highest rating score with an average of 4,4 by the enterprises   

 

 Self-Evaluation 

The main Fields that enterprises in Romania declare that need help are: 

 Creating overseas (70%) 

 Using overseas (50%) 

 Using Embassy/High Commission (55%) 

 

United Kingdom  

In the UK 20 questionnaires collected from Enterprises from all over UK. 

The sample is characterized by reliability and accuracy (proper completion of the 

questionnaires – valuable answers in open type questions. 

 The sample 

The sample was constituted by enterprises that 14 of them declared 10+ years of operation, 

3 of them are start ups, 2 of them declared 0-1 year of experience and 1 of them 1-10 years 

of experience. The 35% of them are Micro, 25% small, 25% Medium and 15% Big (according 

to SMEs definition), thus there is proper representation of the enterprises in the sample.  
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           Figure 8: The size of the sample in the UK 

 

 

In Figure 9 we see the distribution of enterprises according their declared activity. As we can 

see the majority of the enterprises participated in the survey in the UK operate in Textile 

Manufacturing.  
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           Figure 9:  Activity of the sample in UK 

 

 Main Findings  

 

 The 50% of the sample have exports experience 

 40.4 years is the average years of experience of this 50% 

 12 out of 20 of the sample respond that e-shop is their Route to Market 

 41% is the average of exports activity in total income relating to the 50% of the sample 

 

 Why are Exports important  

 

 Attract More Customers – 13 out of 20 enterprises rank as extremely important and 

1 as very important the attractiveness of more customers  

 Lessen Competition – This factor rated in an average of 1,65 by the enterprises  

 Seasonal Market – This factor ranked as the less important as it sum up the bigger 

number of 1 rates (14 enterprises) 

 New Business Model – There is a considerable variance in rating of this factor (from 

1 to 5) without important gravity and an average of 2,15 by the enterprises 

 Improve Cash Flow – This is the second less important factor as more of the 50% of 

the enterprises considered it as no important 
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 Self-Evaluation 

The main Fields that enterprises in the UK declare that need help are: 

 Using Overseas Agents (50%) 

 Finding Trading Partners (35%) 

 Creating an Overseas Sales team (35%) 

 

EURATEX – Belgium, Portugal, Hungary, Bulgaria, France, Italy, 

Lithuania and Croatia  

 

Partner EURATEX as the EU level association and EU social partner, has conducted the 

survey to 12 different EU countries and collected 37 questionnaires as follows:  

Belgium (5), Bulgaria (5), Croatia (6), France (3), Hungary (6), Italy (4), Lithuania (7), 

Portugal (1). 

The sample is characterized by reliability and accuracy (proper completion of the 

questionnaires – valuable answers in open type questions. 

 

 The sample 

The sample was constituted by enterprises that almost all (36 out 37) declared 10+ years 

of operation. The 55% of them are Small, 30% medium and 15% Micro (according to SMEs 

definition), thus there is proper representation of the enterprises in the sample. 

 

 

 

 

 

 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   30 
 

       Figure 10: The size of the sample in 12 countries – EURATEX survey  

 

In Figure 11 we see the distribution of enterprises according their declared activity. As we 

can see the majority of the enterprises participated in the survey are textiles 

manufacturers (20) and 14 are apparel manufacturers.  
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        Figure 11:  Activity of the sample in 12 countries – EURATEX survey 

 

 Main Findings  

 

 The average export experience is more than 34 years.  

 The average percentage of export in income is more than 58% 

 There is a wide variety of replies about the quantities/values the companies 

would like to export that makes it impossible to analyze 

 Countries where companies export are mainly in Europe 

 Outside of the EU, Russia is the country mostly mentioned (4 companies) 

  

 Why are Exports important  

 

 Attract more consumers is the most important reason for exporting (26 

companies) 

 New business model ranks 2nd in importance (14 companies) 

 Lessen competition & seasonal market are less important 

 New Business Model – There is a considerable variance in rating of this factor 

(from 1 to 5) without important gravity and an average of 3,15 by the enterprises 

 Improve Cash Flow – is important 
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 Self-Evaluation 

The main Fields that enterprises from 12 countries declare that need help are: 

 Creating overseas sales team (43%) 

 Using overseas agents (32%) 

 Finding trading partners (27%) 

 Using Embassy / High Commission (27%) 

 

2.3 Future Training Needs  
 

Based on the national results presented above, we will proceed to the identification of the 

overall training needs in EU level, based on the self-evaluation done by the companies 

participated in the survey in each EU country. The overall answers of the self-evaluation for 

the survey in EU level (aggregated data) are presented in ANNEX II.  

Based on these statistical findings we see that in the self – evaluation the majority of the 

companies in EU level need help to the following fields: 

 Creating overseas sales team (53%) 

 Finding trading partners (33%) 

 Intellectual property protection (30%) 

Also, the majority of the companies in EU level declared that they have basic knowledge to 

the following fields: 

 Trademark issues (47%) 

 Insurance issues (43%) 

 Distribution options (40%) 

Following these results, we can form our training needs and conclude that we will need 4-5 

courses on which our curricula will be based in order to address our target group’s needs and 

skills’ gaps. The content of the courses it is proposed to be developed to one of the e-learning 

standards, (SCORM, xAPI).  
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2.4 E- Learning Confidence – EU level  
 

A core question that was included in the survey’s questionnaire was about the level of 

confidence of the companies in E- Learning and training through training platforms. The 

findings we had are very interesting if we both analyze them in national and EU level.  

In table 1 the results from the surveys conducted at national level are presented. As 

mentioned before the results from EURATEX survey represent 8 different EU countries. The 

highlights in this analysis are that companies from Belgium, Portugal, Hungary, Bulgaria, 

France, Italy, Lithuania and Croatia are at 70% confident at e-learning which is the highest 

percentage. In general, the answer “Confident” is the most popular among the majority of the 

companies in every country except the UK where the majority of the companies answered 

that they are Not Confident at e-learning. Also, we have to mention the very high percentage 

of the answer “Very Confident” in Romania and the fact that none of the companies 

participated in the survey answered that they are not confident at e-learning.  

 

                                  Table 1: Results at national level  

How confident you are at e-learning  

  
Very 

Confident 
Confident 

Not 
Confident 

UK 37% 20% 43% 

Greece 16% 63% 21% 

Spain 30% 55% 15% 

Romania 45% 55% 0% 

EURATEX 16% 70% 17% 

 

Analytically the results are presented to the following figures.  
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        Figure 12: National Results for the answer “Very Confident” 
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       Figure 14: National Results for the answer “Not Confident” 
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3. Proposed Modules  

3.1 Summary  
 

Based on the findings of the survey, as presented in Chapter 2 and the basic requirements 

we represent in Chapter 1 we can proceed to the selection and presentation of the required 

modules in order the EXTRO SKILLS digital training platform to cover all the expectations and 

needs of our target group and end users.  

A key requirement for the e-learning platform is that it should contain modules for: 

 System administration. 

 Course management. 

 Content management. 

 Management of user’s teams and companies. 

 Collaboration and videoconferencing. 

 Electronic register. 

 Anti-plagiarism. 

The EXTRO SKILLS platform should also offer localised, online training with user guides: and 

video tutorials covering basic operations such as log-in, navigation, system settings, creating, 

editing, or deleting a course, and other key functions. 

The system should include all modules and functionalities at the time an order is placed. The 

same developers should also be able to connect additional modules, if required, without the 

need for further programming, in order to ensure compatibility with the functionality of 

updated versions and upgrades. The platform should be provided with an unlimited license 

for use of all available modules and functionalities.  

The contractor shall install, configure, adapt and test the platform in order to ensure and 

guarantee its complete working capacity. The contractor shall train administrators and 

teachers to use the system and shall provide relevant documentation (system, technical and 

user documentation). The e-learning platform, including all proposed modules and 

functionalities, should be of proven and tested quality and easy to implement. 
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3.2 Proposed Modules  
 

The EXTRO SKILLS platform shall include the modules and functionalities as presented in the 

following paragraphs of this Chapter. 

 

 Module 1: System Administration 

The administration of the system shall include a full range of functions for the management 

and configuration of system parameters and attributes, data, users and courses. The following 

basic functions shall be included, which cover: authentication, management of rights and 

roles, user management, import and export of users and resources, customisable view, 

management of language packs and log and report management. 

Required Functionalities for System Administration 

 The system should support a number of standard roles (e.g. Administrator, Tutor, 

User/Trainee etc) and have the potential to create an unlimited number of additional 

roles. 

 The system should also be able to create user groups to collaborate, communicate 

and share content. These can also accommodate different groups of users attending 

different courses. 

 The platform should enable users to access resources from external websites. 

 It should be possible to access all administrative tools and functionalities from a single 

interface. 

 System Administrators should be able to set quotas on the disk space for individual 

users, courses and organisations. 

 The administrator should be able to set specific settings for the rights of users based 

on user roles, including settings for bandwidth on e-resource access. 

 The possibility to monitor visits and other statistics of the platform (i.e. number of 

users, time period, etc.). 

 Event log storage and log analysis functionality for the needs of system 

administrators. 

 The following Language packs should be available and included in the RSS module: 

English, French, Greek, Spanish, Romanian. 
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Recommended Functionalities for System Administration 

 A functionality allowing the administrator to move and distribute objects, users, other 

administrators, tools and other items from one association to another, or to another 

unit within the hierarchy by using a graphical user interface without the need to use 

the back-end system or have knowledge of Web programming.  

 A functionality that allows rotation, analysis and management of all system logs 

through graphical user interface without the need to use the back-end system. 

 A functionality that allows integration with external systems through encrypted web 

services from the graphical user interface without the need to use the back-end 

system or have Web programming experience. 

 A functionality that allows the creation of a hierarchical structure of institutions with 

their own system administration within the same installation. It should be possible to 

perform all actions and operations through the graphical user interface without the 

need to use the back-end system or Web programming experience.  
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 Module 2: Course Management 

This module should provide tools for synchronous and asynchronous e-learning, creating, 

editing, saving and deleting e-learning courses and encouraging users’ participation in the 

learning process. The platform should provide an opportunity to post news and 

announcements. It should also provide an opportunity to test, assess and oversee the users’ 

performance. 

Required Functionalities for Course Management 

 An opportunity to assign different roles and rights to the different users, as well as 

assign access rights to various e-resources within the system. 

 Single Sign On authentication protocols that save the specified rights and roles and 

offer students and teachers a single point of access to the entire system. 

 The possibility of producing standard user activity and system access reports and 

creating customized reports without the need for additional programming. 

 The system should dispose of available tools for communication and interaction such 

as a calendar, messages and announcements, and chat. 

 The system should allow the upload of syllabuses that are accessible through 

students’ specific access rights. The objective is to provide students with a source of 

reference and basic information on specific topics that will enable them to efficiently 

participate in the course by undertaking home assignments, exams and other 

components of the e-learning process. 

 The system should allow for the publishing of notices accessible to all students, or by 

assigning specific access rights to relevant students. 

 The possibility to create templates for the courses and a course content wizard to help 

create standard courses from templates. 

 Modern and intuitive Web 2.0 interface with the possibility for the user to customise 

the appearance of the Web interface (colours, fonts, design, background and 

content). A possibility to customise the layout of the platform at the user level, or at 

community or school level. Users should be able to remove modules and change their 

location via drag-and-drop functionality. 

 The possibility to create course catalogues and to search and view training courses 

according to specific rights and roles of individual users in the system. 

 The possibility to integrate and embed images, presentations and video content from 

Flickr, YouTube, Facebook and other social networks without the need for specialised 

knowledge of web development (HTML, CSS, JavaScript). 
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 Support for common file formats and the possibility to embed the content of such 

files, (including: aam, aiff, asf, au, avi, doc, gif, html, htm, jpg, jpeg, jif, mpe, mpg, 

mpeg, moov, mov, pdf, pps, qt, ra, ram, swa, swf, tiff, txt, wav, wpd, xls, xlsx, docx, 

ppt, pptx, wma, wmf and wmv), in addition to display and reproduction of the above-

mentioned file formats within the platform, subject to the availability of the relevant 

plug-ins in the installation of the user’s browser. If the relevant browser plugin is not 

installed (or is unavailable), the platform should run an external desktop application 

to display or play the file. 

 The possibility to create, edit and design learning content without specialised 

knowledge of web programming (HTML, CSS, JavaScript). 

 The possibility to create different sections within a course. 

 Accessibility for disabled people – this should be proved by references from external 

organisations (international/national) related to people with disabilities. 

 The possibility to set an order for accessing educational materials with a view to their 

utilisation in a particular sequence. 

 The possibility to access different content, depending on individual performance. 

 The possibility to change the course settings and make certain tools and parts of the 

course content (in)accessible on specific dates and at specific times. 

 The possibility for the teacher to archive a portion of the course or the entire course. 

 The possibility of automatic notification to users about new activities, publications, 

assignments, examinations, tests, or changes in the course. 

 Teachers should be able to create groups, to control a group’s membership by 

assigning specific rights to users, and to determine what tools are available to certain 

groups. 

 The possibility to publish publicly available information related to the teacher and the 

course. 

 The possibility for online submission of assignments and tests. 

 The possibility to conduct surveys among users in the system. 

 The platform should have the following functionalities for evaluating users: 

o It should be possible for test questions to be defined with additional descriptive 

information (metadata) that allows rapid sorting by subject or other indicators, in 

order to reuse questions in subsequent tests. 

o The tests should allow testing the knowledge of students via online quizzes. 

o The possibility of multiple submission of tests and examinations. 

o The possibility of self-assessment. 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   41 
 

o The possibility for anonymous evaluation by the teacher. 

o The possibility to import and export questionnaires. 

o The possibility to create a repository of questions, allowing repeated use of the 

questions in different courses and tests without the need for recreation. 

o The possibility to set different weights for the automatic evaluation of questions 

and award partial credit. 

o The possibility to set the evaluation criteria for peer evaluation. 

o The possibility for the teacher to evaluate the peer evaluation. 

o The possibility to generate reports. 

 Visualisation of the course progress allowing the user to quickly and easily 

understand where s/he stands in the learning process. 

 Availability of integrated tools for promoting student participation in the learning 

process, such as tools for creation and management of forums (discussion 

boards), journals, blogs, wikis, and for the personal assessment of each 

contribution and comment by individual users without leaving the platform. 

 Automatic addition of the assessments and posts by students in the electronic 

register module described in the documentation. 

 The possibility for personal feedback for the user. 

 Forum members should be able to receive e-mail notifications about changes in 

the forums in which they participate. 

 Journals should be shaped as communication areas between users, allowing the 

accumulation of different kinds of information - learning tasks, materials, home 

assignments and others as well as written feedback from users about the learning 

process. 

 Creation of a centralised location for group project activities, involving 

communication between group members, file sharing, discussions and peer 

assessment between the users in one course and users attending different 

courses. 

 The possibility to use different types of questions in tests, surveys and polls. 

 The possibility to create a bank of questions that can be used by the system in any 

combination of questions to test different students. 

 The possibility to set different weights to questions from different pools. There 

should be algorithms for creating tests with diverse content and an option to 

regulate the level of difficulty. 

 The platform must possess a built-in a system for sending and receiving e-mails. 
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 The system needs to support the import and export of courses, and should 

support SCORM and other generally accepted standards. 

 The possibility to set different indicators to monitor the course activities and 

progress through tools that show key information about the course to students, 

teachers and parents. 

 Tracking the activity level and student progress through standard or specialised 

reports generated by the platform without the need for additional programming. 

 The possibility to set recommended sources of information for educational 

purposes by teachers to students. 

 The teacher or the instructor should be able to quickly and easily check the 

student view of the course without logging out of the system and logging in as a 

student, or switching from one interface to another. 

 The teacher should be able to choose a language pack for certain groups of users, 

or for a particular course, regardless of the system’s language settings. 

 The system should allow students to create and manage their own groups (if they 

are given such rights). 

 The possibility to submit group projects and for teachers to award a group mark. 

 The possibility to assess a student’s personal contribution (individual mark) and 

to provide feedback to each member of the group. 

 The possibility to assess the performance of all students on a single question 

(assessment on question by-question basis). 

 The possibility to separate forums into discussions and topics that can be attached 

to certain elements of the course and its content. 

 The possibility for teachers and students to enter comments under any bit of 

information in the journals. 

 The possibility for teachers to regulate the rights of students to view individual 

journals either partially or fully. 

 The possibility for students to create blogs after the respective rights have been 

assigned by the teacher. 

 Functionality that allows a teacher to issue a warning if individual students fail to 

meet certain individual performance criteria. 

 The possibility of two-way communication between the built-in email system and 

external mail servers. 

 The possibility for each user (student or teacher) to create a personal portfolio 

where they can include information such as: images, projects, reports and other 

personal information, as well as individual access rights to their portfolio. 
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 The possibility to set a required personal portfolio template for various user 

groups 

 

Recommended Functionalities for Course Management 

 The possibility to evaluate blogs. The settings and criteria for blog evaluation 

should be set automatically once the blog is created. 

 Functionality allowing dynamic blog evaluation with multiple components. The 

system should allow the definition of multiple blog evaluation components 

through which to assess interactively users’ performance. 

 The possibility to assess publications in the wiki page (wikis), while assessment 

criteria should be set automatically as soon as the page is created. 

 User-friendly interactive wizard to help turors create objects, i.e. they should be 

able to choose a ready-made structure for the course and a graphic design in 

accordance with the course topic, the age group of students and the teaching 

method (for this function, there should be at least 10 course templates). 

 Functionality that allows the setting of centralised standards for educational 

content and the generation of school reports that show the extent to which the 

content of various course elements, or the entire course, correspond to the 

specified standards. 
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 Module 3: Content Management 

This module should store and manage learning content of all users on the platform in order 

to facilitate work with the learning material. 

Required Functionalities for Content Management 

 The possibility to store and manage any type of content from a centralised location 

where it can be administered, updated and shared. 

 The possibility to set different access rights to users. 

 The possibility of centralised organisation and management of electronic content, 

including multimedia in several different courses rather than duplicating the changes 

in every single course. 

 The possibility for teachers and students to set access rights to specific files and 

directories for a number of different courses, instead of copying the content for each 

course. 

 The possibility to track the history of each file or directory from the content 

management system, i.e. to check which user accessed it, when and from where 

 The possibility to provide summary and history of the file, or the directory. 

 The possibility to keep different versions of the file – the system should be able to 

automatically save the last version of the document and keep all previous versions. 

The possibility to store detailed information about all versions and track changes to 

the file or project made by different users. 

 Graphical functionality resembling the management of files and directories in desktop 

operating systems such as Windows, Linux and Mac. 

 The possibility for users to easily, quickly and conveniently share educational 

resources by assigning access rights to files and folders that can be organised and 

managed by both the administrator and individual users. 

 The possibility for quick and simultaneous update of information from one centralised 

location to different organisations, portfolios and courses. 

 The platform should have a drag-and-drop functionality. 

 The content management module should be fully integrated with the File Managers 

of desktop operating systems (Windows Explorer, Finder, etc.). The system should 

allow access to directories in the information repository direct from the user’s 

desktop via the file managers of operating systems without the need to use a Web 

browser. 

 Teachers should be able to quickly and easily view and manage all the files related to 

their courses. 
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 Visualisation of supported file formats from external websites through hyperlinks. 

 The possibility for controlled sharing of content components with external users. 

 

Recommended Functionalities for Content Management 

 The possibility for users to directly share content with external portals and 

platforms (YouTube, Facebook, etc.) without logging off. 

 The solution should offer advanced content management functionality and 

should be able to create separate information repositories for users and objects 
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 Module 4: Collaboration and Videoconferencing  

This module should provide a virtual environment resembling the actual learning environment 

and containing the required functionality for online learning, such as videoconferencing, in 

addition to facilitating the work on group projects within the class and encouraging interaction 

between users. 

 

 Required Functionalities for Collaboration and Videoconferencing 

 Videoconferencing. 

 Text messaging. 

 The possibility to raise your hand in an online class, give the floor to someone and 

allow online 

 discussions between the students. 

 Recording and playback of audio and/or video messages during certain activities in 

the learning process. 

 Sharing desktop applications. 

 Sharing presentations. 

 Adding an existing sound recording to the current session. 

 An ‘Interactive Whiteboard’ space, to support interaction of all participants 

simultaneously or separately (the rules for such interaction should be set by the 

teacher who acts as moderator). 

 Screen sharing (or sharing parts of the screen). 

 Sharing Web content and management of students’ browsers in order to focus on the 

content imposed by the moderator. 

 The possibility for audio and/or video recording of the session for streaming purposes 

and for reusing the learning material integrated into the platform. 

 Management of the classroom by the teacher, including granting and revoking rights 

for voice and video participation, rights for writing on the whiteboard, assignment and 

withdrawal of rights for writing and receiving text messages, for screen sharing and 

for individual desktop applications. 

 The possibility to make advanced audio and/or video recordings of parts of the 

session, or the entire session, and specify settings for classroom management in the 

absence of a moderator. 
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Recommended Features for Collaboration and Videoconferencing 

 The module for videoconferencing and virtual classroom should allow real-time 

posting of questions and inquiries, which students can respond to in real time. 

 The videoconferencing and virtual classroom module should offer an option to use a 

timer for certain activities with automatic submission of the task after the time limit. 

 The videoconferencing and virtual classroom module should allow for splitting the 

session into individual subgroups or chat rooms to be managed inside the session. 
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 Module 5: Electronic Register 

It stores the results and marks from various examinations, tests, assignments and group 

projects. The system should be able to generate various reports on student performance in 

order to help analyse their performance and attendance. 

Required Functionalities for Electronic Register 

 The possibility to create multi-component evaluation schemes. 

 The possibility of anonymous assessment. 

 The possibility to automatically assess a student’s activity in forums, blogs, journals, 

wikis and student portfolios. 

 The possibility to make a weighted evaluation of several different types of 

performance and the opportunity to individually set different weights for different 

users. 

 Automatically adding marks for homework, examinations, tests and other 

assignments in the 

 electronic register. 

 The possibility of manual editing by the teacher of the automatically generated 

assessments. 

 The possibility to hide personal information about the student from the teacher in 

order for the assessment to be anonymous. 

 The possibility to track changes in the assessments. 

 The possibility for teachers to directly send messages to students and parents from 

the electronic register. 

 The possibility to write notes and information to accompany marks that can be seen 

only by the teacher and/or authorised users. 

 The possibility to generate reports on student progress and analyse the level of 

acquisition of various elements from the learning material. 

 The performance of students can be monitored by the teacher through automated 

reports that reflect student participation in courses and other e-learning activities. 

 An early warning system functionality, if users fail to meet specific performance 

criteria set. 

 The possibility to use colour schemes and a visual displays to show the results 

achieved by users. 
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 Functionality allowing import and export of the electronic register in xls and csv 

format. 

 

Recommended Features for Electronic Register 

 In order to compare achieved results to predefined standards and objectives in 

the educational process, the system should allow for assessment of the elements 

using multi-component evaluations that can be retained, copied and processed. 

 Functionality that enables teachers to identify all components that are to be 

assessed from a single location and to visualise all components for assessment in 

a single screen, regardless of where the elements are located in the structure and 

content of subjects. This functionality should allow the teacher to evaluate all 

collected components awaiting assessment without having to look for them 

throughout the structure of the course. 
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3.3 Quality Requirements  
 

The system should also meet the following quality requirements: 

Productivity – the system should have the capacity to serve a minimum of 100 000 

simultaneous (concurrent) sessions. 

Scalability and flexibility – the system should be able to expand and serve up to one million 

concurrent users, and to allow for additional settings. 

Compatibility – the system should be compatible with current Web standards (HTML, 

XHTML). 

Accessibility – the system should be installed centrally on one or more servers, and should be 

accessible via http or https over the Internet. It should have a Web-based user and 

administrative interface for public and protected sections and, as a minimum, it should be 

compatible with the most popular Internet browsers, such as Internet Explorer v.8 and higher, 

Mozilla Firefox v.3.6 and higher, Safari v.3 and higher and Chrome v.10 and higher. 

Functionality and easy access – the system should be adapted for people with visual 

impairments to allow for ease of access and use. 

Stability – the system should guarantee a secure and reliable learning process. 
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3.4 Technological Requirements  
 

There are also a number of baseline requirements for the technology: 

Interface – the system should be simple and easy to use with an intuitive Web interface, 

following Web 2.0 + trends. 

Architecture – the system should have a standard three-layer model for Web applications, 

consisting of database, application server system and user interface. 

Database – the system data should be stored and managed in a relational database 

management system whose price should be calculated in the applicant’s tender and should 

comply with the following requirements: the possibility of complete backup and recovery, the 

possibility to work with arrays larger than 100 GB, simultaneous operation with unlimited 

number of users. If licensed software is used, all necessary licences have to be reported and 

delivered to the system for implementation and operation of the developed information 

system. Maintenance fees and licence costs should be taken into account to allow the assignor 

to use the software for an indefinite amount of time. 

 

3.5 Other Requirements and Remarks  
 

It is important that the system should be able to be integrated with other existing systems. 

This will provide greater potential for: 

 The ability to convert data from the built-in e-register into table format (xls, csv, etc.) 

in order to develop an interface for automated incorporation of data from existing 

systems. 

 Information integration from the existing SCORM-compatible elements and 

interactive lessons. 
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4. Selection of the Learning Management System software – Moodle 

4.1 Overview  
 

Following the aforementioned analysis and all the elements that are presented in relation to 

the needs of the project and the findings of the survey which was conducted in national level, 

we decided to choose Moodle as the Learning Management System software with which the 

EXTRO SKILLS platform will be developed.  

Moodle is a free on line Learning Management System (LMS) that enables educators to create 

their own private website filled with dynamic courses that extend learning anytime, 

anywhere. The ecodestinations-eplatform.eu has been built on Moodle 3.1 offering a variety 

of features and nearly unlimited possibilities for the student-user, the teacher-user and the 

admin-user, described in the following chapters. Furthermore, as Moodle is an open source 

platform, there are no license fees, which in turn keeps cost low 
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Questions relating to the establishment of and successful operation of the 
EXTRO SKILLS digital training Platform 

Outcomes from IOs investigations 
 

Have regional training needs been successfully 
defined? 

Yes 

Do partners have existing materials which can be 
adapted to meet these regional needs? 

Yes 

Are there SMEs within each region which require 
this training and are willing to co-operate in the 
pilot trials? 

Yes 

Are the necessary hardware/software and 
facilities available in all partner countries? 

Yes 

Given that all partners require videoconferencing 
for the pilots, can manufacturers/distributors 
support their products in EXTRO SKILLS countries? 

Yes 

Will suitable training material in the use of 
videoconferening be available for regional 
trainers prior to the operational phase? 

Yes 

Is it financially possible to achieve the project 
activities within the project budget? 

Yes 

Can the project activities be organised into 
successful co-operation models? 

Yes 

Do the activities fit within the project time-
schedule? 

Yes 

 
 
 
 

4.2 Features  
 

Moodle 3.1 is the latest Long Term Support release and comes packed with user-requested 

features such as full support for Competency Based Education, smoother assignment grading, 

easy retrieval of deleted files, improved tagging and course editing, greater usability for 

students and enhancements to several activities such as forum, workshop and lesson. 

 General Features 

A) Modern and easy to use interface, designed to be responsive and accessible, easy to 

navigate both on desktop and mobile devices. 
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B) Personalized dashboard, designed to be able to organize, display courses and view, at 

a glance, current tasks and messages. 

C) Collaborative tools and activities that enable work and learning together using 

glossaries, forums, wikis, database activities and much more. 

D) All in one calendar tool, that helps in keeping track of calendar, course, deadlines, 

meetings, events etc. 

E) Convenient file manager, that drags and drops files from cloud services such as MS 

OneDrive, Dropbox, Google Drive etc. 

F) Simple text editor, that formats text, uses media and images that work across all web 

browsers and devices. 

G) Notifications, from which users can receive automatic alerts on new assignments, 

events, deadlines, forum posts and also send private messages to one another. 

H) Track progress, within an array of activities, resources, or course level. 

 Administrative Features 

A) Customizable site design and layout with logos, images, videos, color schemes and 

much more. 

B) Secure authentication and mass enrolment, with over 50 authentication and 

enrolment options to add and enroll users. 

C) Multilingual capability, that allows users to view content in their own language or set 

it up for multilingual users and organizations. As requested, languages have been set in English 

and Greek. 

D) Bulk course creation and easy back up 

E) Supports open standards that readily imports and exports IMS-LTI, Scorm courses and 

more into Moodle. 

F) Manage user roles and permissions, address security concerns by defining roles to 

specify and manage user access. 

G) Detailed reporting and logs, concerning activity and participation at course and site 

level. 
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H) Regular security updates, with the latest security patches. 

I) Simple plugin management, that permits install or disable plugins within a single 

admin interface. 

J) High interoperability, which integrates external applications and content, also 

providing the ability to create plugin for custom integration. 

1.3. Course development and management features 

A) Direct learning paths to meet various requirements. Classes can be instructor-led, self-

paced, blended or entirely on line. 

B) Multimedia integration, that enables to easily search and insert videos, images, 

charts, audio files into courses. 

C) Group management, where learners can share courses, activities, or facilitate team 

work. 

D) Marking workflow, which conveniently assign different markers to assignments, 

manage grade moderation and control when marks are released to individual learners. 

E) In line marking, that easily reviews and provides in-line feedback by annotating on 

PDF files directly within browser. 

F) Peer and self-assessment, with built-in activities such as workshops and surveys 

encourages learners to view, grade and assess their own and other course members' work as 

a group. 

G) Integrated badges, fully compatible with Mozilla Open Badges, motivate learners and 

reward participation and achievement with customized Badges. 

H) Outcomes and rubrics, that allows selecting from advanced grading methods to tailor 

the gradebook to certain course or examination criteria. 

I) Security and privacy, in teaching and sharing. 
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4.3 Technical Description – Teacher’s Guide  
 

In Moodle, the teacher has responsibility for the materials in his/her own course. The teacher 

also manages enrolments and is able to change the layout of the course page. Moodle 

Learning Management System (LMS) offers a wide variety of tools (resources and activities) 

to facilitate the course delivery effectively. Online user guides are developed to obtain the 

setup procedures and tips of effective course management in Moodle. Three basic categories 

will be discussed such as Course Administration, Add Resource and Add an Activity. 

 Course set up 

A course is a space on a Moodle site where teachers can add learning materials for their 

students. A teacher (the person that has course update capabilities - which are assigned by 

default only to the teacher role or the manager role) may have more than one course and a 

course may include more than one teacher and more than one group of learners. A course 

can display its materials in a number of ways or 'formats' for example in weekly sections or 

named topic sections. All these can be shown at once can be revealed one at a time. Course 

sections may be renamed by turning on the editing and clicking the configuration icon 

underneath the section name. Sections may also be moved by drag and drop and sections 

added or removed by clicking the + or - underneath the bottom section. So the teacher can 

change course settings in  

Administration > Course administration > Edit settings 

 Course settings 

The following will provide detailed information about creating, organizing and managing 

courses in Administration > Course administration > Edit settings 

General 

Course full name 

This is the name of the course. It is displayed as a link on course lists on the Front page, on the 

Dashboard and in reports. It is also used in the browser title bar when the course is viewed. 

The capability moodle/course:changefullname controls whether a user can edit the course full 

name.  

Short name 

This is a shorthand way of referring to a course, such as BP102 or Astrof104. Even if there is 

no such name for the course, it is advised to make one up here. It will be used in several places 
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where the long name is not appropriate, such as the Navigation block. The capability 

moodle/course:changeshortname controls whether a user can edit the short name field. By 

default, only course full names are displayed in the list of courses.  

However an the administrator can enable short names to be displayed too if required by 

ticking the checkbox in Administration > Site administration > Appearance > Courses 

Course category 

The site administrator may have created course categories to help teachers and students find 

their courses easily. Course categories may be reflected in the Navigation block. The capability 

moodle/course:changecategory controls whether a user can edit the course category.  

 

Course start date 

This setting affects the display of logs and the weekly format topic dates. If you use the 

"Weekly" course format, the start date will appear in the first section of the course. For 

example selecting 27 July, will display "27 July - 2 August" in the first section (when default 

display is selected for that section). This setting will have an effect on the display of logs. This 

will be the earliest possible date the log activity will display. This setting will not affect courses 

using the 'social' or 'topics' formats.  

Visible 

Here you can "hide" your course completely. It will not appear on any course listings, except 

for managers, course creators, teachers and any other users with the view hidden courses 

capability. Even if students try to access the course URL directly, they will not be allowed to 

enter. The hide/show courses capability controls whether a user can hide a course.  

 

Course ID number 

The ID number is an alphanumeric field. It has several potential uses. Generally, it is not 

displayed to students. However, it can be used to match this course against an external 

system's ID, as your course catalogue ID or can be used in the certificate module as a printed 

field. The capability moodle/course:changeidnumber controls whether a user can edit the ID 

number.  
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Description 

 

 

 

 

 

 

 

 

 

Course summary 

The summary appears on the course listings page. This field is searched when searching for a 

course and also appears in the Course/Site description block. The capability 

moodle/course:changesummary controls whether a user can edit the course summary.  

  

Course summary files 

An image (and if allowed by the administrator, other file types) may be attached to the course 

summary. They will be accessible by anyone from outside of the course just like the course 

name and/or summary. Only users with moodle/course:changesummary capability are able 

to upload/change course summary files. If this is not allowed by the administrator, then no 

box will appear to upload course summary files. By default, only jpg, gif and png file types are 

allowed as course summary files. An administrator can change the allowed file types in  

Administration > Site administration > Appearance > Courses 

 

Course format 

(These settings are collapsed by default.) 
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A course format refers to the layout of a course. The course format can be selected in 

 Administration > Course administration > Edit settings 

An administrator can enable, disable or delete course formats for courses in  

Administration > Site administration > Plugins >Course formats > Manage course formats 

They can also change the order in which available course formats are displayed to teachers in 

the course settings.  

Standard course formats 

 

1)Weekly format 

The course is organized week by week, with a clear start date and a finish date. Moodle will 

create a section for each week of your course. You can add content, forums, quizzes, and so 

on in the section for each week. 

2)Topics format 

The course is organized into topic sections that a teacher can give titles to. Each topic section 

consists of activities, resources and labels.  

3)"Show only one section" 

With the weekly, topics and any contributed format that implements the functionality, it is 

possible via Administration > Course administration > Edit settings to "show one section per 

page".  

4)Social format 

This format is oriented around one main forum, the social forum, which appears listed on the 

main page. It is useful for situations that are more free form. They may not even be courses. 

The social forum can be edited by clicking the 'Update this forum' button on the social forum 

page. The forum introduction is displayed at the top of the course page. Activities and 

resources can be added on the side by using the Social activities block. 

 

5)Single activity format 

The single activity format only has one section, and allows the teacher to add one activity only 

to the course. When the single activity format is selected, a drop down menu appears for the 

teacher to choose the activity they wish to use. There is also the "See also" section for a 
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screencast and working example of the single activity course format. It is possible here to 

select a SCORM package as the single activity. Single activity format with a forum as the 

activity and social format are very similar. The only difference is when the course contains 

other activities. The single activity format displays them as "orphaned" and for teachers only; 

the social format displays them in an activities block and available for students.  

 

6)Contributed Course Formats 

The Moodle community has developed a number of course formats, available in the plugins 

directory. 

 

7)Buttons course format 

The Buttons course format creates a menu with buttons in JavaScript to access the sections, 

one by one. It has features to create group of sections (example: modules, period) and change 

the button colors.  

 

8)Collapsed Topics 

It is essentially the same as the standard Topic and Weekly formats but with a 'toggle' for each 

section except '0'. The toggles' purpose is to reduce the amount of initial information 

presented to the user thus reducing the 'scroll of death' that can plague courses with a lot of 

content. The 'state' of the toggles is remembered on a per course per user basis.  

 

9)Daily format 

It is a modification of the weekly format that shows sections by day rather than by week.  

 

10)Grid format 

It is a modular and visual course format. Hides all topics and creates a grid of icons (one for 

each topic) with short titles. Clicking on an icon brings up the content from the corresponding 

topic in a "lightbox" style display.  

 

11)Menutopic format 

Allows displaying the topics/sections in a menu.  

 

12)Noticeboard format 

It presents the latest post in the news forum at the top of the course.  
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13)One topic format 

It shows each topic in a tab, keeping the current tab between calls to resources, in such a way 

that when it returns from a module as the blog or the glossary it returns to tab from where 

you started. This format is based on the Moodle standard format: “Topics”.  

 

14)Topic format (colors) 

It is based on the 'Topics' standard format and allows a teacher to specify the foreground and 

background colors for each course section.  

 

15)Flexible sections format 

Allows to have nested sections and each section may be displayed expanded (with all content 

on the parent section page) or collapsed (as a link to a separate page). Other contributed 

course formats are available from the modules and plugins database.  

 

 Restrict access 

The restrict access feature enables teachers to restrict the availability of any activity or even 

a course section according to certain conditions such as dates, grade obtained, group or 

activity completion.  

  

In version 3.1, Restrict access is enabled by default in new installations.  

If there is no a 'Restrict access' option when setting up course activities and sections, check 

with the administrator that it is enabled in  

Site administration > Advanced features 

 

 Adding a new course 

By default a regular teacher can't add a new course. To add a new course to Moodle, you need 

to have either Administrator, Course Creator or Manager Rights. To add a course, go to 

Administration>Site Administration>Courses>Manage courses and categories 

• Click on the category where you want your course to be. For more information you 

may see Course categories 

• Click the "New course" link 
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• Enter the course settings, and then choose either to "Save and return" to go back to 

your course, or "Save and display" to go to the next screen. 

• On the next screen, if you have chosen "Save and display", choose your 

students/teachers to assign to the course. 

 

 Deleting a course 

Teachers cannot delete courses. Managers (i.e. users with a role for which the capability 

moodle/course:delete is allowed) can delete courses and  course creators  can delete courses 

they have created themselves, but only within 24 hours of creating the course. This is so that 

courses created by mistake may be deleted without needing to ask an administrator. 

Administrators can always delete courses. 

To delete a course (as an admin or manager): 

• Go to Administration > Site Administration > Courses > Manage courses and 

categories 

• Click the course's category and click the course in the screen on the right. 

• Click the Delete link. 

• You can delete multiple courses by: 

• Creating a new (temporary) category. You can name it "To be deleted". 

• Select and move the "About to be deleted" courses to that category ("To be deleted"). 

• Delete the category ("To be deleted") and choose "Delete ALL - cannot be undone". 

There is no user interface for course creators to delete courses they have created;  

however, they can do so by editing the URL of the course from 

http://yourmoodlesite.net/course/view.php?id=N to 

http://yourmoodlesite.net/course/delete.php?id=N (replacing 'view' with 'delete'). 
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 Sorting courses 

Courses may be sorted by an admin or manager from  

Administration>Site administration>Courses>Manage courses and categories. 

Courses may be sorted by ascending/descending and by time created. 

 

 Course templates 

It is possible, from  Administration>Site Administration>Courses>Upload courses  to specify a 

course and settings to use as template for future courses. Default blocks for new courses can 

also be configured in config.php. 

Using an existing course as a template 

First, create or locate the course you wish to use as a template and make a note of its 

shortname. A template course might for example have common headings or section 

summaries or policy agreements used throughout the site for consistency. Keep in mind, that 

only the content of the course will be restored; not its settings. Settings are added separately. 

Method 1 

 Create your csv file. You may see Upload courses for accepted fields. 

 From  Site administration>Administration>Courses>Upload courses, add your file. 

 Preview it and scroll down to 'Course process'. In the box 'Restore from this course 

after upload', add the shortname of your template course. 

 If you are creating several courses using the same template and you wish them all to 

have the same settings, you can specify these in the Default course values. 

 Upload your csv file. 
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Adding shortname of template course 

 

 

Default course values 

 

Method 2 

 All the settings and the chosen template course can be specified in the csv file you 

create. Use  templatecourse  as the field for your chosen template course, and use the 

course shortname. See  Upload courses  for full list of fields you can include. 

 Here is an example of a csv file for restoring a course to be used as a template. It 

specifies for example the theme, language, enrolment method and alternative names 

for student and teacher. 

shortname,fullname,category,newsitems,theme,lang,format,enrolment_1,enrolment_1_role,role_student,role_t

eacher,templatecourse 

Knit,Knitting,2,0,afterburner,fr,topics,manual,student,NewKnitter,MasterKnitter,OMT 

 Go to Administration>Site administration>Courses>Upload courses and add your csv 

file. 

 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   65 
 

Using a backup course as a template 

It is possible during the process of creating courses with a csv file in  Site 

administration>Administration>Courses>Upload courses  to specify and upload a backup file 

to be used as a template. 

 Create your csv1 file.  

 From Site administration>Administration>Courses>Upload courses, add your file. 

 Preview it and scroll down to 'Course process'. In the box 'Restore from this file after 

upload', add the backup file you wish to use as the template. 

 If you are creating several courses using the same template and you wish them all to 

have the same settings, you can specify these in the 'Default course values' section. 

 Alternatively, you can specify the course settings (such as format, enrolment 

methods, language) in the csv file. This method is useful if you wish different courses 

using the same template to have different settings. 

 Upload your csv file. 

 Uploading a template course 

                                                           
1 In computing, a comma-separated values (CSV) file stores tabular data (numbers and text) in plain 

text. Each line of the file is a data record. Each record consists of one or more fields, separated by 

commas. The use of the comma as a field separator is the source of the name for this file format. 

The CSV file format is not standardized. The basic idea of separating fields with a comma is clear, but 
that idea gets complicated when the field data may also contain commas or even embedded line-
breaks. CSV implementations may not handle such field data, or they may use quotation marks to 
surround the field. Quotation does not solve everything: some fields may need embedded quotation 
marks, so a CSV implementation may include escape characters or escape sequences. 
In addition, the term "CSV" also denotes some closely related delimiter-separated formats that use 
different field delimiters. These include tab-separated values and space-separated values. A delimiter 
that is not present in the field data (such as tab) keeps the format parsing simple. These alternate 
delimiter-separated files are often even given a .csv extension despite the use of a non-comma field 
separator. This loose terminology can cause problems in data exchange. Many applications that accept 
CSV files have options to select the delimiter character and the quotation character. 
 

https://en.wikipedia.org/wiki/Computing
https://en.wikipedia.org/wiki/Computer_file
https://en.wikipedia.org/wiki/Tabular
https://en.wikipedia.org/wiki/Plain_text
https://en.wikipedia.org/wiki/Plain_text
https://en.wikipedia.org/wiki/Record_%28computer_science%29
https://en.wikipedia.org/wiki/Field_%28computer_science%29
https://en.wikipedia.org/wiki/Comma
https://en.wikipedia.org/wiki/File_format
https://en.wikipedia.org/wiki/Delimiter-separated_values
https://en.wikipedia.org/wiki/Tab-separated_values
https://en.wikipedia.org/wiki/Filename_extension
https://en.wikipedia.org/wiki/Data_exchange
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         Uploading a template course 

 Editing text 

The usual way to edit or create text that is part of the visual content of a course is using the 

Text editor (also known as the HTML editor). 

The way to edit the text in the content area depends on the current role or permissions of the 

user in a context. 

A teacher will see many  ("edit settings") icons on a course's home page when "Turn editing 

on" button has been clicked. Or they will see the HTML editor and content area within many 

activities and resources. For example, a teacher can edit the text that appears at the top of a 

section in a course by clicking on the edit hand icon. 

A student and a teacher will see the HTML tool when they reply to a forum post but will not 

have the ability of changing a topic heading in the course. 

Teachers and administrators should be aware that the Moodle code contains "strings" of text 

that can be edited though customizing the language on a site wide basis. 

 Text editor 

The text editor (also referred to as the 'HTML editor') has many icons to assist the user in 

entering content. Many of these icons and functions should be familiar to anyone who uses a 

word processor. Some examples of where you will see the text editor include: Editing Section 

headings, description of an activity, writing an answer to a quiz question or editing the content 

of many blocks. The default text editor in Moodle is the Atto editor, built specifically for 

Moodle. There is also a version of the TinyMCE editor and a plain text editor.  
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Text editors can be enabled, disabled or a different one set to default from  Administration > 

Site administration > Plugins > Text editors > Manage editors. The order of priority may also 

be specified here. 

If more than one text editor is enabled, users can select their preferred editor via their 

preferences page in the user menu (top right). 

Atto HTML editor 

 

 

Atto Row 1 

1:Expand 2.Style 3.Bold 4.Italic 

 

5.Bulleted list 6.Numbered list 7.Add link 8.Unlink 

9.Add image 10.Add media 11.Manage embedded files  
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Atto Row 2 

1. Underline 2. Strikethrough 3. Subscript 4. Superscript 

5. Align left 6. Align centre 7. Align right 8. Increase indent 

9. Decrease indent 10. Equation 

editor 

11. Special 

character 

12. Table 

13. Clear formatting 14. Undo/redo 15. Undo/redo 16. Accessibility 

checker 

17. Screenreader 

helper 

18. HTML/code 

view   

 

Image drag and drop 

If your browser allows it (and if it does, you will see a message at the top of your screen when 

the editing is on) you can add images into the Atto editor simply by dragging them from your 

computer. 

Autosave 

Text typed into the Atto editor is automatically saved if you leave the page. The default of 60 

seconds may be changed by the administrator in  

Site administration>Plugins>Text editors>Atto HTML editor>Atto toolbar settings 
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If the user accidentally closes the tab or otherwise leaves the form without submitting, the 

text in the editor will be restored next time he opens the page. To discard a restored draft, 

the user needs to cancel the form or press the "Undo" button in the editor. 

 

Accessibility checker 

One of the tools available in the text editor is an automated accessibility checker which checks 

for some common errors in the text. These are usually things in the way the text is constructed 

that can prevent all users from having equal access to information and functionality. The list 

of problems that the accessibility checker looks for is: 

 Images with missing or empty alt text (unless they have the presentation role) 

 Contrast of font color and background color meets WCAG AA guidelines 

 Long blocks of text are sufficiently broken up into headings 

 All tables require captions 

 Tables should not contain merged cells as they are difficult to navigate with screen 

readers 

 All tables should contain row or column headers 

 

Screenreader helper 

Screen readers basically treat a content editable region like a text box - which is wrong, 

because it can contain images, links and more. The screen reader helper provides additional 
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information about the currently selected text (e.g. is it bold), as well as a listing of any images 

or links in the text. 

Equation editor 

If either the  MathJax  or the  TeX notation  filters are enabled in  

Administration > Site administration > Plugins > Filters > Manage filters 

then an equation editor button is provided in the toolbar for launching the equation editor.  

In Moodle 3.0 onwards, extra buttons are provided for square roots, fractions and vectors. 

 

Equation editor 

Table editor 

If the administrator has enabled the extra settings for the Atto table editor (see below) then 

border styling, sizing and colours are available when creating a table: 
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Site administration settings 

Toolbar settings 

The administrator can specify which plugins to display and in which order from   

Administration > Site administration > Plugins > Text editors > Atto HTML editor > Atto toolbar 

settings 
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Atto Plugins 

 

Toolbar config table 

The toolbar is split into groups of related buttons. The format for the config setting is:  

groupname1 = button1, button2, button3 groupname2 = button1, button2, button3 

The group names on the left have no effect on how the toolbar works; they just need to be 

different for each button (and no spaces please). The list of buttons says which button goes in 

which group and in what order. The exact word to insert here for each button is listed in the 

"Toolbar config" column above.  

The reason there are names for the groups is that it helps to make you think about how to 

group the buttons sensibly and not just stick new buttons in random locations. For instance 

all the buttons in the "files" group interact with the file picker in some way. 

Adding extra buttons 

Extra plugins from the list (for example 'Font color' or 'Emoticon') may be added by typing the 

toolbarconfig term into the toolbar config table. 
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The available colors when 'fontcolor' is added, are shown below: 

 

The icons are displayed in related groups and the administrator can decide how many groups 

to display in the default collapsed state of the toolbar.  

Autosave frequency 

Text is automatically saved at regular intervals so it may be restored when the user returns to 

a form they had previously left. This setting allows the administrator to specify the time 

between autosaves. The default is one minute. 

Non default Atto plugins 

Not all plugins are enabled by default and the administrator of each site should give careful 

thought as to which plugins they choose to enable for their users.  

Here are some things to consider before enabling the non-default plugins: 
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Background color / Font color 

While these are very popular plugins, there are downsides to enabling their use on a site. 

Firstly - user specified colors may conflict visually with the site colors chosen by the theme 

designer. Even if the colors of the content do not conflict with the colors of the current theme, 

if the theme is changed in future, or the content is reused on a different site conflicts may be 

introduced. There are two possible types of conflicts, the first is just a visually unappealing 

combination of colors, the second is a combination of colors that may produce text that is 

hard to read for some people. It is preferable if the theme designer uses some interesting 

colors that meet the accessibility standards required for the site in the theme for the site, and 

the person creating the content simply uses the proper heading levels (for example) to make 

use of those styles. 

Emoticons 

The emoticon plugin inserts text representations of the emoticons in the content. The 

emoticon filter is responsible for converting these text sequences into proper smiley images.  

The emoticon filter is not enabled by default, which is why the emoticon plugin for Atto is not 

enabled by default. 

No-auto link 

In general, the more plugins are added to the Atto toolbar, the harder it becomes to find 

specific plugins. Because the no-auto link plugin is not felt to be widely used it is not enabled 

by default. 

Right to left 

Because this plugin is only useful for courses where text needs to be written in a mixture of 

both "left to right" and "right to left" languages, it is not enabled by default. 

Moodle plugins directory 

There are more plugins available for Atto than just those included in a default install. See 

the  Moodle plugins directory  for additional plugins. 
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 Some example plugins include the following: 

Toggle preview 

This plugin allows you view the content as it would be seen by a reader. 

Chemistry plugins 

There are a number of chemistry plugins that support chemistry equations and structures. 

Text import plugins 

There are a number of plugins that support importing text from other sources. The  Paste 

special  plugin minimizes the amount of superfluous HTML markup included when pasting 

content from an external editor such as Microsoft Word. 

The  Word Import  plugin (beta) supports importing an entire Word document, including 

embedded images. 

Equation editor settings 

Equation editor commands may be removed, added or reordered in  

Administration > Site administration > Plugins > Text editors > Atto HTML editor > Equation 

editor settings 

 

Table editor settings 

Styles, colors and sizes for tables and their borders may be enabled from  

Administration > Site administraton >Plugins > Test editors > Atto HTML editor > Table settings 
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 Formatting text 
 

Formatting text options 

The Text editor  is available for all text areas in Moodle and the format is automatically set to 

HTML format (Atto being the default editor). However, if the setting 'Editor preferences' from 

the user menu top right > Preferences is set to 'Plain text area', then various format options 

are available in a dropdown menu below the text area. 

 

 

HTML format 

When writing HTML in Moodle, you are free to use almost any HTML tags you like to produce 

the effect you want. Note that scripting such as Javascript or VB Script, is not allowed, and will 

be removed automatically. Code will normally be printed on the page within a table cell, so: 

There is no need to use any <HEAD> or <BODY> tags 

Be careful about unmatched </TABLE> tags that may mess up the display. 

Anything starting with www. or http:// will automatically be turned into a clickable link 

(assuming the  Convert URLs into links filter is enabled by an administrator). 

This format assumes the text is pure HTML. If you are using the text editor to edit text then 

this is the default format - all the commands in the toolbar are producing HTML for you. Even 

if you are not using the text editor, you can use HTML code in your text and it should come 

out exactly as you intended. 

Moodle auto-format 
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This format is best for when you are using normal web forms for entry (instead of using the 

text editor). Just type text normally, as if you were sending an email. 

When you save your text, Moodle will do a number of things to automatically format your text 

for you. As for HTML format, websites will automatically be turned into a clickable link 

(assuming the  Convert URLs into links filter  is enabled by an administrator). 

Smiley characters such as  :-) will automatically become their graphical equivalents (assuming 

the  Display emoticons as images filter  is enabled by an administrator). 

 

Your line breaks will be retained, and blank lines will start new paragraphs. You can even 

embed HTML code if you want to and it will be retained. 
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Plain text format 

This format is useful when you need to include lots of code or HTML that you want to be 

displayed exactly as you wrote it. It still translates spaces and new lines, but otherwise your 

text isn't touched. 

Markdown text format 

Markdown  format tries to make it easy as possible to type well-formatted XHTML pages using 

nothing but text written more or less like you would write an email. It's very good for writing 

clean text pages with some headings and some lists but without many links or images. It is an 

excellent choice when accessibility of the generated page is important. An unordered list may 

be created with asterisks (*). 

Tips and Tricks 

Wrong Characters Showing - If some users do not see the same characters or figures, have 

them check their browser settings for their character settings. At Moodle.org, the 

recommended default character decoding set is UTF-8. On a Firefox browser, this can be found 

in Tools>Options>Fonts & colors>advanced>default character decoding pull down menu. If 

that doesn't work you can try installing a UTF-8 Unicode font from:   http://titus.fkidg1.uni-

frankfurt.de/unicode/tituut.asp.  

 

 

https://docs.moodle.org/31/en/File:Html_tags.png
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 Activities 

An activity is a general name for a group of features in a Moodle course. Usually an activity is 

something that a student will do that interacts with other students and or the teacher. In 

Moodle terminology, an Activity, such as Forums or Quizzes, properly means something 

students can contribute to directly, and is often contrasted to a Resource such as a File or 

Page, which is presented by the teacher to them. However, the term activity is sometimes for 

convenience also used to refer to both Activities and Resources as a group. There are 14 

different types of activities in the standard Moodle that can be found when the editing is 

turned on and the link 'Add an activity or resource' is clicked. 

 Types of activities 

Assignments 

Enable teachers to grade and give comments on uploaded files and assignments created on 

and off line 

Chat 

Allows participants to have a real-time synchronous discussion 

Choice 

A teacher asks a question and specifies a choice of multiple responses 

Database 

Enables participants to create, maintain and search a bank of record entries 

Feedback 

For creating and conducting surveys to collect feedback. (The administrator needs to enable 

this) 

Forum 

Allows participants to have asynchronous discussions 

 

https://docs.moodle.org/31/en/Assignment_activity
https://docs.moodle.org/31/en/Chat_activity
https://docs.moodle.org/31/en/Choice_activity
https://docs.moodle.org/31/en/Database_activity
https://docs.moodle.org/31/en/Feedback_activity
https://docs.moodle.org/31/en/Forum_activity
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Glossary 

Enables participants to create and maintain a list of definitions, like a dictionary 

Lesson 

For delivering content in flexible ways 

(LTI) External tool 

Allows participants to interact with LTI compliant learning resources and activities on other 

web sites. (These must first be set up by an administrator on the site before being available in 

individual courses) 

Survey 

For gathering data from students to help teachers learn about their class and reflect on their 

own teaching 

Wiki 

A collection of web pages that anyone can add to or edit 

Workshop 

Enables peer assessment. Additional plugins from the  Moodle plugins directory  may also be 

installed on the site. 

Quiz 

Allows the teacher to design and set quizzes, which may be automatically marked and 

feedback and/or to correct answers shown. More analytically on quizzes: 

Changing the order of the question types 

The administrator can specify the order the question types appear in the question chooser so 

that teachers are presented with the most common ones at the top. This is done from  Site 

administration > Plugins > Question types > Manage question types.  The administrator uses 

the arrows to reorder the question types. By default, in new installations of Moodle, the most 

common question types will appear first: 

https://docs.moodle.org/31/en/Glossary_activity
https://docs.moodle.org/31/en/Lesson_activity
https://docs.moodle.org/31/en/External_tool
https://docs.moodle.org/31/en/Survey_activity
https://docs.moodle.org/31/en/Wiki_activity
https://docs.moodle.org/31/en/Workshop_activity
https://docs.moodle.org/31/en/Quiz_activity
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Default order in new installs 

 Standard question types in quizzes 

Calculated 

Calculated questions offer a way to create individual numerical questions by the use of 

wildcards that are substituted with individual values when the quiz is taken.   

Calculated multi-choice 

Calculated multichoice questions are like multichoice questions with the additional property 

that the elements to select can include formula results from numeric values that are selected 

randomly from a set when the quiz is taken. They use the same wildcards than Calculated 

questions and their wildcards can be shared with other Calculated multichoice or regular 

Calculated questions. 

The main difference is that the formula is included in the answer choice as {=...} i.e if you 

calculate the surface of a rectangle {={l}*{w}}. 
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Calculated simple 

Simple calculated questions offer a way to create individual numerical questions whose 

response is the result of a numerical formula which contain variable numerical values by the 

use of wildcards (i.e {x} , {y}) that are substituted with random values when the quiz is taken. 

The simple calculated questions offer the most used features of the calculated question with 

a much simpler creation interface. 

Drag and drop into text 

Students select missing words or phrases and add them to text by dragging boxes to the 

correct location. Items may be grouped and used more than once.  

Drag and drop markers 

Students drop markers onto a selected area on a background image. Unlike the Drag and drop 

onto image question type, there are no predefined areas on the underlying image that are 

visible to the student. 

Drag and drop onto image 

Students make selections by dragging text, images or both to predefined boxes on a 

background image. Items may be grouped. 

Description 

This question type is not actually a question. It just prints some text (and possibly graphics) 

without requiring an answer.  

This can be used to provide some information to be used by a subsequent group of questions. 

Essay 

This allows students to write at length on a particular subject and must be manually graded.  

It is possible for a teacher to create a template to scaffold the student's answer in order to 

give them extra support.  

The template is then reproduced in the text editor when the student starts to answer the 

question.  
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Matching 

A list of sub-questions is provided, along with a list of answers. The respondent must "match" 

the correct answers with each question.  

Embedded Answers (Cloze Test / Gap Fill) 

These very flexible questions consist of a passage of text (in Moodle format) that has various 

answers embedded within it, including multiple choice, short answers and numerical answers. 

Multiple choices 

With the Multiple Choice question type you can create single-answer and multiple-answer 

questions, include pictures, sound or other media in the question and/or answer options (by 

inserting HTML) and weight individual answers. 

Short Answer 

In response to a question (that may include an image), the respondent types a word or phrase.  

There may several possible correct answers, with different grades. Answers may or may not 

be sensitive to case.  

Numerical 

From the student perspective, a numerical question looks just like a short-answer question.  

The difference is that numerical answers are allowed to have an accepted error. This allows a 

continuous range of answers to be set.  

Random short-answer matching 

From the student perspective, this looks just like a Matching question.  

The difference is that the sub-questions are drawn randomly from Short Answer questions in 

the current category. 
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Select missing words 

Students select a missing word or phrase from a dropdown menu. Items may be grouped and 

used more than once.  

True/False 

In response to a question (that may include an image), the respondent selects from two 

options: True or False.  

Third-party question types 

Besides the standard question types that are part of the core Moodle distribution, there are 

a number of  question type add-ons  in  the add-ons database. 

Print screens on ecodestinations quizzes 

One of the many ways to create a quiz test with four possible answers, for example, is to write 

the questions and then save them as a txt.file. Then at the course’s page, click Add an activity 

or resource.  

 

 

 

 

 

 

 

Then select Quiz from the Activities list. 
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On this window, you may choose the features of the quiz and decide on timing, grading, 

appearance, descriptions, restrictions, settings, tags, modules etc.  

 

 

 

 

 

 

 

 

Once you are done, click on Save and display.  

Then the txt.file is imported in the quiz (while firstly it has been entered in the proper 

category). 

 Recourses 

A resource is an item that a teacher can use to support learning, such as a file or link. Moodle 

supports a range of resource types which teachers can add to their courses. In edit mode, a 

teacher can add resources via the 'Add an activity or resource' link. Resources appear as a 

single link with an icon in front of it that represents the type of resource. 

Administrators can decide whether or not to force teachers to add descriptions for each 

resource by enabling or disabling a site-wide setting in  

Administration > Plugins > Activity modules > Common settings 

• Book - Multi-page resources with a book-like format. Teachers can export their Books 

as IMS CP (admin must allow teacher role to export IMS) 

• File - A picture, a pdf document, a spreadsheet, a sound file, a video file 
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• Folder - For helping organize files and one folder may contain other folders 

• IMS content package - Add static material from other sources in the standard IMS 

content package format 

• Label - Can be a few displayed words or an image used to separate resources and 

activities in a topic section, or can be a lengthy description or instructions 

• Page - The student sees a single, scrollable screen that a teacher creates with the 

robust HTML editor 

• URL - You can send the student to any place they can reach on their web browser, for 

example Wikipedia 

 Blocks 

Blocks are items which may be added to the left or right or center column of any page in 

Moodle. They may also be added to the center of the Dashboard. Any block can be made 

'sticky' so that it appears in all the contexts below, such as throughout a course or a particular 

activity. Blocks can be placed on the side of the screen. If a responsive theme (such as 'Clean') 

is used, blocks will be accessible from the bottom of smaller screens, below the main content. 

Available blocks include:  

Activities Learning plans Messages 

Activity results Logged in user Navigation 

Admin bookmarks Login Network servers 

Administration Main menu Online users 

Blog menu Mentees block People 

Blog tags Messages Private files 

https://docs.moodle.org/31/en/Activities_block
https://docs.moodle.org/31/en/Learning_plans_block
https://docs.moodle.org/31/en/Messages_block
https://docs.moodle.org/31/en/Activity_results_block
https://docs.moodle.org/31/en/Logged_in_user_block
https://docs.moodle.org/31/en/Navigation_block
https://docs.moodle.org/31/en/Admin_bookmarks_block
https://docs.moodle.org/31/en/Login_block
https://docs.moodle.org/31/en/Network_servers_block
https://docs.moodle.org/31/en/Administration_block
https://docs.moodle.org/31/en/Main_menu_block
https://docs.moodle.org/31/en/Online_users_block
https://docs.moodle.org/31/en/Blog_menu_block
https://docs.moodle.org/31/en/Mentees_block
https://docs.moodle.org/31/en/People_block
https://docs.moodle.org/31/en/Blog_tags_block
https://docs.moodle.org/31/en/Messages_block
https://docs.moodle.org/31/en/Private_files_block
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Calendar Navigation Quiz results 

Comments Network servers Random glossary entry 

Community finder Online users Recent activity 

Course completion status People Recent blog entries 

Course overview Private files Remote RSS feeds 

Course/site summary Quiz results Search forums 

Courses Random glossary entry Section links 

Feedback Recent activity Self completion 

Flickr Learning plans Social activities 

Global search Logged in user Tags 

HTML Login Upcoming events 

Latest announcements Main menu Youtube 

Latest badges Mentees block From plugins database 

 

 Tracking progress 

There are several ways to track student progress in Moodle. This section outlines what is 

available to teachers in a course. 

 

 

https://docs.moodle.org/31/en/Calendar_block
https://docs.moodle.org/31/en/Navigation_block
https://docs.moodle.org/31/en/Quiz_results_block
https://docs.moodle.org/31/en/Comments_block
https://docs.moodle.org/31/en/Network_servers_block
https://docs.moodle.org/31/en/Random_glossary_entry_block
https://docs.moodle.org/31/en/Community_finder_block
https://docs.moodle.org/31/en/Online_users_block
https://docs.moodle.org/31/en/Recent_activity_block
https://docs.moodle.org/31/en/Course_completion_status_block
https://docs.moodle.org/31/en/People_block
https://docs.moodle.org/31/en/Recent_blog_entries_block
https://docs.moodle.org/31/en/Course_overview_block
https://docs.moodle.org/31/en/Private_files_block
https://docs.moodle.org/31/en/Remote_RSS_feeds_block
https://docs.moodle.org/31/en/Course/site_summary_block
https://docs.moodle.org/31/en/Quiz_results_block
https://docs.moodle.org/31/en/Search_forums_block
https://docs.moodle.org/31/en/Courses_block
https://docs.moodle.org/31/en/Random_glossary_entry_block
https://docs.moodle.org/31/en/Section_links_block
https://docs.moodle.org/31/en/Feedback_block
https://docs.moodle.org/31/en/Recent_activity_block
https://docs.moodle.org/31/en/Self_completion_block
https://docs.moodle.org/31/en/Flickr_block
https://docs.moodle.org/31/en/Learning_plans_block
https://docs.moodle.org/31/en/Social_activities_block
https://docs.moodle.org/31/en/Global_search_block
https://docs.moodle.org/31/en/Logged_in_user_block
https://docs.moodle.org/31/en/Tags_block
https://docs.moodle.org/31/en/HTML_block
https://docs.moodle.org/31/en/Login_block
https://docs.moodle.org/31/en/Upcoming_events_block
https://docs.moodle.org/31/en/Latest_announcements_block
https://docs.moodle.org/31/en/Main_menu_block
https://docs.moodle.org/31/en/Youtube_block
https://docs.moodle.org/31/en/Latest_badges_block
https://docs.moodle.org/31/en/Mentees_block
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Grades 

Every course has its own Gradebook which is accessible from Course administration > 

Grades. Some activities such as Assignment and Quiz send grades back to this gradebook. It is 

also possible for teachers to enter grades directly into the gradebook. 

 

 

Competencies 

They describe the level of understanding or proficiency of a learner in certain subject-related 

skills. Competency-based education (CBE), also known as Competency-based learning or 

Skills-based learning, refers to systems of assessment and grading where students 

demonstrate these competencies. 

Activity completion 

It is enabled by the administrator and in the course settings, teachers can indicate for each 

course item how they wish it to be registered as complete. A tick/checkmark will then appear 

against the activity. Students may either mark it complete manually or the item will 

automatically be registered as complete once a student has met the specified criteria. These 

may be viewing a resource, submitting an assignment, posting in a forum or other conditions.  

The teacher can see an overview of who has completed what in the activity completion report 

in   Course administration > Reports > Activity completion 
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Student view 

 

Teacher view 

Course completion 

As an extension of activity completion, enabling Course completion allows for a course to be 

officially marked as finished, either manually or automatically according to specified criteria. 

If the  Course completion status block  is added, students can see their progress during the 

course. Teachers can view the overall progress of students towards course completion 

from Course administration>Reports>Course completion. 

 

Student view 

 

Teacher view 
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Course reports 

A number of Course reports are available to the teacher in their course to help them track the 

progress of their students. In addition to the activity and course completion reports 

mentioned above (which are only available if these settings are enabled) there are also activity 

reports, participation reports and general course logs. 

Badges 

Badges2 can be awarded either manually or using activity completion settings in a course and 

are a popular way to motivate students. Students may be awarded badges at different stages 

of the course for different levels of progress. 

Contributed plugins 

Certificate activity - an additional plugin 

Progress Bar block - an additional plugin 

 

 

 

 

 

 

 

                                                           
2 Badges are a good way of celebrating achievement and showing progress. They may be awarded based 
on a variety of chosen criteria and are fully compatible with Mozilla Open Badges. Badges created in 
Moodle may be displayed on a user’s profile or pushed to their Open Badges backpack and public badge 
collections in their backpack will display in their Moodle profile. There are two categories of badges: 
Site badges (available to users site-wide and related to the site wide activities like finishing a set of 
courses) and Course badges (available to users enrolled in the course and related to the activities that 
happened inside the course). 
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4.4 SCORM – Web Based Learning Content  
 

Enables SCORM3 packages to be included as course content. SCORM (Sharable Content Object 

Reference Model) is a collection of specifications that enable interoperability, accessibility and 

reusability of web-based learning content. SCORM content can be delivered to learners via 

any SCORM-compliant Learning Management System (LMS) using the same version of 

SCORM. 

Adding a SCORM package 

First - make sure you have created a course. 

Quick method: 

(Note - does not work with versions of Internet Explorer earlier than IE10) 

1. Click the 'Turn editing on' button at the top right of the course page 

2. Drag and drop the SCORM package zip file onto the course section where you'd like it to 

appear 

3. Answer 'Add a SCORM package' to the popup dialogue asking what you want to do with 

the zip file then click the upload button 

4. If necessary, edit the title of the file by clicking the pencil icon, or edit other options (see 

below) by clicking the editing icon 

 

Longer method: 

1. Click the 'Turn editing on' button at the top right of the course page 

                                                           
3 SCORM is a set of technical standards developed for eLearning software products. It enables 
interoperability between eLearning software products. It actually determines how online learning 
content and LMS (Learning Management System) communicate with each other. For example, if 
someone designs eLearning content using tools like Articulate, Captivate, Camtasia or Raptivity and 
needs to upload the content in an LMS, then Scorm enables that. The way it works is that content can 
be created in any eLearning authoring tool and then published by the tool in a Scorm conformant way. 
To the user it looks like a zip file when published to Scorm. However, this zip package contains all of the 
files needed to make that eLearning content run and because it’s been packaged up in line with Scorm 
standards, it is ready to be uploaded in to any Scorm-compliant LMS and then delivered out to learners.  

https://docs.moodle.org/31/en/SCORM_activity
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2. Click the 'Add an activity or resource' link in the section you wish to add your SCORM 

package, then in the activity chooser, select SCORM package then click the Add button (or 

select 'SCORM package' from the 'Add an activity' dropdown menu) 

3. Enter a name and a description (which may be required or optional according to the admin 

settings) 

4. Either drag and drop a SCORM package zip file into the box with an arrow or click the Add 

button to open the File picker menu in order to choose a file from your computer or a 

repository 

5. Select display and other options as required (see below) 

6. Click the button 'Save and display' at the bottom of the page 

You can edit or update the SCORM package later by clicking on the edit icon (usually a 

hand/pen) or by clicking on its name and then  

Settings > SCORM/AICC administration > Edit settings 

Keep in mind that, Moodle does not generate SCORM content.  

Moodle presents the content in SCORM packages to learners, and saves data from learner 

interactions with the SCORM package.  

Course settings 

General 

 

General settings expanded by default 

Name 



 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   93 
 

Whatever you type here will form the link learners’ click on to access the SCORM package, so 

it is helpful to give it a name that suggests its purpose. 

Description 

Add a description of your SCORM activity here. Click "Show editing tools" to display the rich 

text editor, and drag the bottom right of the text box out to expand it. 

Display description on the course page 

If this box is ticked, the description will appear on the course page just below the name of the 

SCORM activity. 

Package 

This setting determines which SCORM package is used by this SCORM activity. Drag and drop 

or click the icon top left to upload your SCORM package. (Note that you must not unzip the 

package before upload). The default (1) is to be able to upload a file. If your admin has added 

additional options in 

 Site administration>Plugins>Activity modules>SCORM package 

then these will be available in a dropdown menu (2). 

 

Package settings expanded by default 

Alias/Shortcut 
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If you access your SCORM package from a repository (such as  File system 

repository  or  Private files) you can choose to create an alias/shortcut to it and then set an 

update frequency to set how often Moodle should check to see if there is an updated zip.  

Selecting an imsmanifest.xml 

It is possible to select the imsmanifest.xml file and have it as an alias/shortcut. To do this, you 

need to have created a File system repository4 and, when configuring it, allowed relative files. 

Extract your SCORM package into a folder there.  

When clicking on the Add button to add your SCORM package, select the file system repository 

folder with your SCORM package and browse for and select the imsmanfest.xml file, ensuring 

you the option to create an alias/shortcut to the file. Save and display (this method is only 

currently supported by the File system repository).  

Note: The settings (Type, URL and Auto-update frequency) are only available when configured 

globally.  

 

Appearance 

(These settings are collapsed by default) 

                                                           
4 The file system repository allows access to files which have been uploaded (e.g. via FTP) into 

designated folders on the server. (Note that these folders are not created inside the Moodle site, but on 

the server where Moodle is hosted.) 

A file system repository may be available site wide for everyone or within an individual course (set up 
by admin) or for an individual administrator. This must be done by a systems admin who has write 
permissions to the server directories. When a file from the file system repository is re-used elsewhere 
on Moodle, the teacher has the option to make a copy (a new, unconnected version) or to create a 
shortcut or alias. See Working with files for more details. 
Once a repository has been created and files uploaded to it, the files can be made available within the 
file picker for use within a course. There are several steps to take to implement this feature. 
These must be done by a systems admin who has write permissions to the server directories and admin 
permissions within Moodle. (https://docs.moodle.org/31/en/File_system_repository) 

https://docs.moodle.org/31/en/Working_with_files
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Display package 

Choose from current or new window. Note that if you choose a new window, students need 

to ensure pop ups are enabled. 

Display course structure on entry page 

If this is enabled then the table of contents of the package will be displayed when the students 

clicks to access the package. 

Show Navigation 

This setting determines whether the navigation buttons are shown or not. 

1. No -they are hidden 

2. Under content - they are displayed underneath the SCORM package 

 

Appearance settings expanded 
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3. Floating - the navigation buttons are floating5  

Display attempt status 

You can choose whether to display a summary of the student's attempts on the entry page, 

on their Dashboard page or both. This setting is helpful when debugging grading issues - 

working out why a user got a certain grade. 

The following settings become visible when "Show more" is clicked: 

Width 

Stage size width as a css value, either % or pixels.  

Default is 100%. You can change to a different percentage by putting a % symbol after the 

number (ex. 80%). You can also set to a pixels value by entering a number higher than 100 (ex. 

800). 

Height 

Stage size height as a css value, either % or pixels.  

Default is 500 pixels. You can change to a percentage by putting a % symbol after the number 

(ex. 80%). You can also set to a pixels value by entering a number higher than 100 (ex. 800). 

Options 

There is a series of check boxes for: Allow the window to be resized ad scrolled, displaying 

directory links, location bar, menu bar, toolbar and/or status. 

 Student skip content structure page - never, first access, always 

 Disable preview mode - If this option is set to Yes, the Preview button in the view page 

of a SCORM/AICC Package activity will be hidden. The student can choose to preview 

(browse mode) the activity or attempt it in the normal mode. When a Learning Object 

is completed in preview (browse) mode, it's marked with browsed icon 

 Display course structure in player 

 

                                                           
5 With options to choose the position from the left and top 
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Availability 

(These settings are collapsed by default.) 

 

Availability settings expanded 

Choose here the dates you wish the SCORM package to be available to students. 

Grade 

(These settings are collapsed by default) 

 

Grade settings expanded 

Grading method 

o Learning Objects - This mode shows the number of completed/passed Learning 

Objects for the activity. The max value is the number of Package's Learning 

Objects. Tip: If your SCORM package does report cmi.core.lesson_status, and does 

not report cmi.core.score.raw, then you should use this setting. 

o Highest grade - The grade page will display the highest score obtained by users in all 

passed Learning Objects. Tip: If your SCORM package does report cmi.core.score.raw, 
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and does not report cmi.core.lesson_status, then you should use this setting, Average 

grade, or Sum grade. 

o Average grade - If you choose this mode Moodle will calculate the average of all 

scores. 

o Sum grade - With this mode all the scores will be added. 

Maximum grade 

Not applicable if Grading Method is Learning objects. Usual setting is 100. If your SCO 's high 

score is something other than 100, you should adjust this value appropriately. When grading 

Method is one of the score settings, then the gradebook grade is package score divided by 

this number. 

Attempts management 

(These settings are collapsed by default.) 

 

Attempts management screen expanded 

Number of attempts 

Defines the number of attempts permitted to users. It works only with SCORM 1.2 and AICC 

packages. SCORM2004 has its own max attempts definition. 

o The option to start a new attempt is provided by a checkbox above the Enter button 

on the content structure page, so be sure you're providing access to that page if you 

want to allow more than one attempt. 

o An attempt is not complete until the cmi.core.lesson_status for the attempt is set to 

either 'completed' or 'passed'. After that, the  Start new attempt  checkbox is available 

to the learner. 
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Attempts grading 

When you permit multiple attempts for students, you can choose how to record the result in 

gradebook by first, last, average or highest settings. 

Display attempt status 

If enabled, scores and grades for attempts are displayed on the SCORM outline page. This 

setting makes the block display more info to the user on the entry page to the SCORM and in 

the course overview block - if you turn it off it will display less info. This setting is helpful when 

debugging grading issues - working out why a user got a certain grade. 

Force new attempt 

If this is enabled then every time the student accesses the package, it will count as a new 

attempt. 

Lock after final attempt 

If this is enabled then once a student has used up all their attempts, they can no longer access 

the SCORM package. 

Compatibility settings 

(These settings are collapsed by default.) 

 

Compatibility settings expanded 

 

Auto-Continue 

For SCORM packages that contain multiple learning objects (or SCO's) and Auto-continue is 

set to Yes, when a Learning Object calls the "close communication" method the next available 
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object is launched automatically. If it is set to No, the users must use the navigation provided 

to continue to the next object. Many SCORM packages only contain a single learning object 

(or SCO) so this setting does not apply. 

TIP: If your package contains multiple branches Auto-Continue will only move from one object 

to the next within the same topic. 

Force completed 

If this is enabled then the status of the current attempt is set to "complete". Note that this 

only applies to SCORM 1.2 packages and is useful if the SCORM package does not handle 

revisiting an attempt correctly, in review or browse mode, or otherwise incorrectly issues the 

completion status. 

 

Auto commit 

Some SCORM packages don't explicitly call Commit() regularly for whatever reason so 

progress is not stored in the database. This patch will Commit() the data from the SCORM 

package 60 seconds after the values are set, unless the package Commit()s sooner. 

This means that 

 A SCORM package can be restricted to a particular grouping 

 SCORM reports may be filtered by group 

 

SCORM report filtering by group 

See Common module settings for more information. 

Restrict access 

These settings will be available if  Conditional activities  are enabled. 
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Activity completion settings 

If this has been enabled for the course, then SCORM completion may be set based on 

minimum score or status (e.g. "Passed"). 

 

Save settings 

 

As in most activities there are 3 save button choices. Cancel, Save and return to 

course and Save changes buttons. The Save changes button will take the teacher back to the 

SCORM "stage" page. 

Site administration settings 

These options are available to the site admin via  

Site administration > Plugins > Activity Modules > SCORM Package 

Default Value Settings 

Many of the settings available in the SCORM Package administration simply set the default 

value for the SCORM activity module setup options provided within courses. Edit these 

settings to save yourself time when adding large numbers of packages, or to establish a 

standard for presentation across the site. 

Other Important Settings 

https://docs.moodle.org/31/en/File:scormscore1.png


 

 

Developing New Skills for the Extroversion 

Specializations of Fashion Industry in Europe – 

EXTRO SKILLS 

Grant Agreement No.: 2015-1-EL01-KA202-013907 

FEASIBILITY STUDY 

Intellectual Output 4 

 

 

 

 

 
Erasmus+ Project: 2015-1-EL01-KA202-013907                                                                                                                      

 

This project has been funded with support from the 

European Commission. 

This publication [communication] reflects the views only of 

the author, and the Commission cannot be held 

responsible for any use which may be made of the 

information contained therein. 

   102 
 

The following options provided which do not simply set a default value for the SCORM activity 

editing page view. 

 

Auto-update frequency 

If not using a standard SCORM package uploaded using the filepicker and the SCORM package 

is hosted outside your Moodle installation the option to auto-update the package will be 

available - you can elect to have the package updated on every entry to the package or daily 

via the Moodle cron. 

Synchronization time 

Enable SCORM 1.2 standard mode 

If this setting is disabled, then it will be possible to exceed the allowed amount of stored data 

for SCORM 1.2 packages. Many SCORM packages go over the 4096 characters limit and while 

SCORM 2004 allows a higher number of characters, it is not supported. This setting will mean 

users can allow their 1.2 packages to store more data. 

Enable external package type 

If selected, presents a text field to paste a URL to a remote imsmanifest.xml (in an unzipped 

remote SCORM package), as well as the file picker option provided by default. The content is 

played from the designated location, and not unpacked into the Moodle file system. So if the 

base url is different from your moodle url then browser security will block cross-domain 

communcation and no grades/tracking information will be passed back to Moodle. 

Enable downloaded package type 

If selected, presents a text field to paste a URL to a remote package.zip SCORM package. 

Package is downloaded and unzipped into the Moodle file system. 

Enable IMS package type 

Enables a package to be selected from within an IMS repository 

Force users to enable JavaScript 
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Since the SCORM API uses JavaScript to save data to Moodle, this is a valuable idea. 

Activate API debug and tracing (set the capture mask with apidebugmask) 

Turns on debugging for SCORM activities. In Moodle 2 you no longer have to also turn on 

debugging in the developer options. 

API debug capture mask 

.* will debug for admin user only: You can use the mask to enable debugging under certain 

conditions. For example, if you are logged in using the admin user (username admin) you can 

set the api mask to: admin.* Users not logged in as admin will not see the debugging log. The 

"Default" api mask is .*  which translates roughly to  everybody. 

Enable direct AICC url 

Makes it easier to connect to externally hosted AICC content as the teacher doesn't have to 

create an AICC package and is able to link directly to the external AICC url. 

Enable external AICC HACP 

The SCORM activity can also support external AICC HACP Communication where the AICC 

package is hosted on an external content providers site and passes back http requests directly 

from the external server instead of within the users’ web browser session - this is disabled by 

default. 

AICC pass numeric user id 

Protect package downloads. 

This is disabled by default, meaning packages can always be downloaded (eg for offline mobile 

use). If this is enabled then only users with the capability course: manage activities can 

download the package. 
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4.5 Technical Description – Student’s Guide  
 

Some advanced capabilities for the student user, are the following: 

Assessing and grading 

Learning plans 

If your organization/school etc. uses learning plans with Competency based education, you 

can view your learning plans from your profile or a Learning plans block on your dashboard. 

You can also upload evidence of prior learning. 

Check progress and request reviews 

Click a learning plan to view the competencies, check their status, request a review or find 

other courses with those competencies.  

Receive annotated assignment submissions 

If enabled by the administrator, you can upload docx or odt files as assignment submissions 

and they will be converted to pdf files with the teacher's annotations ready for you to 

download and view.  

Usability 

Bulk download files  

If your teacher has added folders to your course, you can now download all the files inside 

them as a zipped folder for easy offline access.  

Find tagged activities 

Activities and resources can now be tagged by the teacher, making it easy for you to find 

related useful content. 

Communication 

Send messages more efficiently 

You can now find the Message button directly next to the user's picture, making it much easier 

to get in touch. 
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Link directly to forum posts  

A new permalink feature allows you easily to copy and share direct links to important forum 

posts.  

 

4.6 Installing Plugins  
 

Installing a plugin 

To install a plugin, its source code must be put (deployed) into the appropriate location inside 

the Moodle installation directory and the main administration page Administration > Site 

administration > Notifications must be visited. There are three ways how the plugin code can 

be deployed into Moodle.  

Plugin code may be deployed from within Moodle, either directly from the Moodle plugins 

directory or by uploading a ZIP file. The web server process has to have write access to the 

plugin type folder where the new plugin is to be installed in order to use either of these 

methods.  

Alternatively, a plugin may be deployed manually at the server.  

Installing directly from the Moodle plugins directory 

1. Login as an admin and go to Site administration > Plugins > Install plugins. (If you can't 

find this location, then plugin installation is prevented on your site.) 

2. Click the button 'Install plugins from Moodle plugins directory'. 

3. Search for a plugin with an Install button, click the Install button then click Continue. 

4. Confirm the installation request 

5. Check the plugin validation report 

 

Installing via uploaded ZIP file 

 Go to the Moodle plugins directory, select your current Moodle version, then choose 

a plugin with a Download button and download the ZIP file. 
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 Login to your Moodle site as an admin and go to Administration > Site administration 

> Plugins > Install plugins. 

 Upload the ZIP file. You should only be prompted to add extra details (in the Show 

more section) if your plugin is not automatically detected. 

 If your target directory is not writeable, you will see a warning message. 

 Check the plugin validation report 

 

Installing manually at the server 

If you can't deploy the plugin code via the administration web interface, you have to copy it 

to the server file system manually (e.g. if the web server process does not have write access 

to the Moodle installation tree to do this for you).  

First, establish the correct place in the Moodle code tree for the plugin type. Common 

locations are:  

 /path/to/moodle/theme/ - themes 

 /path/to/moodle/mod/ - activity modules and resources 

 /path/to/moodle/blocks/ - sidebar blocks 

 /path/to/moodle/question/type/ - question types 

 /path/to/moodle/course/format/ - course formats 

 /path/to/moodle/admin/report/ - admin reports 

See dev:Plugins for the full list of all plugin types and their locations within the Moodle tree.  

1. Go to the Moodle plugins directory; select your current Moodle version, then choose 

a plugin with a Download button and download the ZIP file. 

2. Upload or copy it to your Moodle server. 

3. Unzip it in the right place for the plugin type (or follow the plugin instructions).  

4. In your Moodle site (as admin) go to Settings > Site administration > Notifications (you 

should, for most plugin types, get a message saying the plugin is installed). 

The plugin may contain language files. They'll be found by your Moodle automatically. These 

language strings can be customized using the standard Settings > Site administration > 

Language editing interface. If you get a "Database error" when you try to edit your language 

files, there is a strong chance that the language files included within the downloaded ZIP file 

of this plugin have a coding problem. If you delete the 

http://docs.moodle.org/dev/Plugins
https://moodle.org/plugins
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plugin_name/lang/other_language_different_to_English/ folder with the new language 

strings and the database error disappears, this is indeed the case. If that is the case, the idea 

is to please notify the plugin maintainer, so that it can be fixed in future releases. 

 

4.7 Security Issues  
 

All web application software is highly complex, and every application has security issues that 

are found from time to time, usually involving some combination of input that the 

programmers did not anticipate. The Moodle project takes security seriously, and is 

continuously improving Moodle to close such holes as we find them. 

 The best security strategy is a good backup! But you don't have a good backup unless 

you are able to restore it. Test your restoration procedures. 

 Load only software or services you will use. 

 Perform regular updates. 

 Model your security after the layers of clothing you wear on a cold winter day. 

Basic recommendations 

 Update Moodle regularly on each release 

 Published security holes draw crackers attention after release. The older the version, 

the more vulnerabilities it is likely to contain. 

 Register globals MUST be disabled! 

 This will help prevent against possible XSS problems in third-party scripts. 

 Use strong passwords for admin and teachers 

 Choosing "difficult" passwords is a basic security practice to protect against "brute 

force" cracking of accounts. 

 Only give teacher accounts to trusted users. Avoid creating public sandboxes with free 

teacher accounts on production servers. 

 Teacher accounts have much freer permissions and it is easier to create situations 

where data can be abused or stolen. 

 Separate your systems as much as possible. 
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 Another basic security technique is to use different passwords on different systems, 

use different machines for different services and so on. This will prevent damage 

being widespread even if one account or one server is compromised. 

 

Run regular updates 

 Use auto update systems 

 Windows Update  

 Linux: up2date, yum, apt-get 

 Consider automating updates with a script scheduled via cron  

 Mac OSX update system 

 Stay current with php, apache, and moodle 

 

Use mailing lists to stay updated 

 CERT - http://www.us-cert.gov/cas/signup.html 

 PHP - http://www.php.net/mailing-lists.php - 

 MySQL - http://lists.mysql.com  

 

Firewalls 

 Security experts recommend a dual firewall 

Differing hardware/software combinations  

 Disabling unused services is often as effective as a firewall 

Use netstat -a to review open network ports 

 Not a guarantee of protection 

 Allow ports  

80, 443(ssl), and 9111 (for chat),  

Remote admin: ssh 22, or rdp 3389 

 

 

 

http://www.us-cert.gov/cas/signup.html
http://www.php.net/mailing-lists.php
http://lists.mysql.com/
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Password policy 

A password policy may be set up in Settings > Site administration > Security > Site policies.  

There is a check box to determine if password complexity should be enforced or not, the 

option to set the minimum length of the password, the minimum number of digits, the 

minimum number of lowercase characters, the minimum number of uppercase characters and 

the minimum number of non alphanumeric characters.  

If a user enters a password that does not meet those requirements, they are given an error 

message indicating the nature of the problem with the entered password.  

 Enforcing password complexity along with requiring users to change their initial 

password go a long way in helping ensure that users choose and are in fact using 

"good passwords".  

 Have backups ready  

 Practice recovery procedures ahead of time  

 Use a rootkit detector on a regular basis  

 Linux/MacOSX - http://www.chkrootkit.org/  

 Windows - http://technet.microsoft.com/en-en/sysinternals/bb897445.aspx and 

http://technet.microsoft.com/de-de/sysinternals/bb897445.aspx 

 

Moodle security alerts 

 Register your site with Moodle.org 

 Registered users receive email alerts 

 Security alerts also posted online 

 Web - http://moodle.org/security 

 RSS feed - http://moodle.org/rss/file.php/1/1/forum/996/rss.xml 

 

Miscellaneous considerations 

These are all things you might consider that impact your overall security:  

 Use the secure forms setting 

 Always set a mysql root user password 

https://docs.moodle.org/31/en/Site_policies
http://www.chkrootkit.org/
http://technet.microsoft.com/en-en/sysinternals/bb897445.aspx
http://technet.microsoft.com/de-de/sysinternals/bb897445.aspx
http://moodle.org/security
http://moodle.org/rss/file.php/1/1/forum/996/rss.xml
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 Turn off mysql network access 

 Use SSL, httpslogins=yes 

 Use good passwords - set up a password policy in Settings > Site administration > 

Security > Site policies 

 Do not enable the opentogoogle setting (in Settings > Site administration > Security > 

Site policies) 

 Disable guest access 

 Place enrollment keys on all courses or set Course Enrollable = No for all courses 

 Ensure the enrolment key hint is disabled (which it is by default) in Administration > 

Site administration > Plugins > Enrolment > Self enrolment. 

 

Most secure file permissions that applies to Linux/Unix installations 

Depending on your server set-up there are two different scenarios:  

1. You are running Moodle on your own dedicated server 

2. You are running Moodle on a shared hosting environment 

In the sections below, you are required to use the web service user account and group to set 

the permissions, so you need to know them. This can vary quite a bit from server to server but 

if this feature has not been disabled in your server, you can go to 

http://your.moodle.site/admin/phpinfo.php (logging in as admin), and then search for the 

line that reads 'User/Group', inside the 'apache' table. For example, I get 'www-data' for the 

user account and 'www-data' for the group too.  

Running Moodle on a dedicated server 

Assuming you are running Moodle on a sealed server (i.e. no user logins allowed on the 

machine) and that root takes care of the modifications to both moodle code and moodle 

config (config.php), then this are the most tight permissions I can think of:  

1. moodledata directory and all of its contents (and subdirectories, includes sessions):  

owner: apache user (apache, httpd, www-data, whatever; see above) 

group: apache group (apache, httpd, www-data, whatever; see above) 

permissions: 700 on directories, 600 on files 

http://your.moodle.site/admin/phpinfo.php
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2. moodle directory and all of its contents and subdirectories (including config.php):  

owner: root 

group: root 

permissions: 755 on directories, 644 on files. 

If you allow local logins for regular users, then 2. should be:  

owner: root 

group: apache group (apache, httpd, www-data, whatever; see above) 

permissions: 750 on directories, 640 on files. 

Think of these permissions as the most paranoid ones. You can be secure enough with less 

tighter permissions, both in moodledata and moodle directories (and subdirectories).  

Running Moodle on a shared hosting environment 

If you are running Moodle on a shared hosting environment, then above permissions are 

probably wrong. If you set 700 as the permission for directories (and 600 for files), you are 

probably denying the web service user account access to your directories and files.  

If you want to tighten your permissions as much as possible, you will need to know:  

1. The user account and the group the web service is running under (see above). 

2. The owner of the directories/files of both moodledata and the moodle directory (this 

should normally be your client user account), and the group of the directories/files. 

You can usually get this information from the file manager of your hosting control 

panel. Go to the moodle folder and pick any directory or file and try to view/change 

the permissions, owner and group of that file. That would normally show the current 

permissions, owner and group. Do the same for the moodledata directory. 

Then, depending on the following scenarios you should use a different set of permissions 

(listed from more secure to less secure) for your moodledata directory:  

1. if the web service account and the owner of the directories/files is the same, you 

should use 700 for directories and 600 for files. 
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2. if the web service group and the group of the directories/files is the same, you should 

use 770 for directories and 660 for the files. 

3. if none of the above, you will need to use 777 for directories and 666 for files, which 

is less secure but it is your only option. 707 and 606 would be more secure, but it 

might or might not work, depending on your particular setup. 

In fact, you just need to set moodledata the permissions specified above, as all the directories 

and files inside are created by the web service itself, and will have the right permissions.  

Regarding the Moodle directory, as long as the web service user account can read the files 

plus read and execute the directories, that should be enough. There is no need to grant write 

permission to the web service account/group on any of the files or subdirectories. The only 

drawback is that you will need to create the config.php by hand during the installation process, 

as Moodle will not be able to create it. But that should not be a big problem.  

Site policies 

A site administrator can set site policies affecting the security and privacy of the site in 

Administration > Site administration > Security > Site policies. 

Protect usernames 

If enabled, when a user attempts to reset their password and enters a username or email 

address, the following message is displayed: "If you supplied a correct username or email 

address then an email should have been sent to you." This is to prevent a malicious party from 

using the interface to determine which usernames and email addresses are in use in valid 

accounts.  

If the protect usernames setting is disabled, when a user attempts to reset their password 

they are provided with feedback regarding whether an account exists with the username or 

email address supplied. For example, the message "The email address was not found in the 

database" may be displayed.  

Force users to login 

If you turn this setting on, all users must login before they even see the Front Page of the site.  

In the ecodestinations-eplatform, the Front Page is open to everyone, but to enter a course, 

login is requested . 
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Force users to login for profiles 

Leave this set to Yes to keep anonymous visitors away from user profiles.  

Force users to login to view user pictures 

If enabled, users must login in order to view user profile pictures and the default user picture 

will be used in all notification emails.  

Open to Google 

Enabling this setting allows Google's search spiders guest access to your site. Any part of the 

site that allows guest access will then be searchable on Google. In addition, people coming in 

to your site via a Google search will automatically be logged in as a guest.  

Profile visible roles 

Any role which is checked/ticked here will be visible on user profiles and the Participation 

screen.  

Maximum uploaded file size 

Probably the most frequently asked question in the Moodle.org Using Moodle forums is "How 

do I increase the upload file size limit?"  

Upload file sizes are restricted in a number of ways - each one in this list restricts the following 

ones:  

1. The Apache server setting LimitRequestBody ... default in Apache 2.x or greater is set to 0 

or an unlimited upload size  

2. The PHP site settings post_max_size and upload_max_filesize in php.ini : modify php.ini in 

web server directories ( apache2.x.x/bin/php.ini ) not in php directories :  

post_max_size = 128M;  to increase limit to 128 Megabytes; 

upload_max_filesize = 128M;  to increase limit to 128 Megabytes; 

max_execution_time = 600 ; Maximum execution time of each script, in seconds; 
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3. The Moodle site-wide maximum uploaded file size setting: Settings > Site administration > 

Security > Site policies > Maximum uploaded file size.  

4. The Moodle course maximum uploaded file size setting in the course default settings: 

Settings > Site administration > Courses > Course default settings  

5. The file size settings in each individual course in Course Administration>Settings.  

5. Certain course activity module settings (for example, Assignment)  

User quota 

The maximum number of bytes that a user can store in their own Private files area.  

Allow EMBED and OBJECT tags 

Allowing these presents a security risk but if you wish normal users such as students to be 

able to use them then check the box here.  

Enable trusted content 

By default Moodle will always thoroughly clean text that comes from users to remove any 

possible bad scripts, media etc that could be a security risk. The Trusted Content system is a 

way of giving particular users that you trust the ability to include these advanced features in 

their content without interference. To enable this system, you need to first enable this setting, 

and then grant the Trust submitted content capability to a specific Moodle role. Texts created 

or uploaded by such users will be marked as trusted and will not be cleaned before display.  

Maximum time to edit posts 

This sets the editing time for forum postings. The editing time is the amount of time users 

have to change forum postings before they are mailed to subscribers.  

Please refer to the forum discussions Editing a forum post after the 30 minutes deadline and 

The philosophy underlying "no editing after 30 minutes"  

Full name format 

This setting has been moved in Moodle 2.6 onwards to Administration > Site administration > 

Users > Permissions > User policies.  

https://docs.moodle.org/31/en/Private_files
http://moodle.org/mod/forum/discuss.php?d=28679
http://moodle.org/mod/forum/discuss.php?d=5367
https://docs.moodle.org/31/en/Roles_settings
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Allow extended characters in usernames 

The default here, unchecked = unenabled, can only contain alphabetical letters in lowercase, 

numbers, hypen '-', underscore '_', period '.', or at sign '@'. If you enable this, it will be possible 

to have any characters for the username, but they must still be lowercase. This setting would 

allow you for example to have usernames with accents such as ö or ê and so on.  

Site policy URL 

 

Site policy link on signup page 

 If you have a site policy that all users must see and agree to before using this site, then 

specify the URL to it here, otherwise leave this field blank. The URL can point to any 

type of file anywhere online that can be accessed without a log in to your Moodle. 

 It is recommended that the site policy is on the same domain as Moodle to avoid the 

problem of Internet Explorer users seeing a blank screen when the site policy is on a 

different domain. 

 The site policy will be displayed in a frame. You can view it via the URL 

yourmoodlesite.org/user/policy.php. 

 If Email-based self-registration is enabled on the site, a link to the site policy is 

displayed on the signup page. 

It is not recommended that a page resource is used as a site policy, since the site header will 

be repeated in the iframe. 

When a site policy URL is set, all users will be required to agree to it when they next log in 

before accessing the rest of the site.  

https://docs.moodle.org/31/en/File:site_policy_link.png
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Site policy URL for guests 

This is similar to the Site policy URL as above. Guest users will need to agree to it before 

accessing a course with Guest access enabled.  

Keep tag name casing 

If checked, then tags like the following will be displayed: SOCCER, gUiTaR, MacDonalds, music  

If unchecked, then all tags will be displayed as follows: Soccer, Guitar, Macdonalds, Music  

Tips:  

 For English, off is useful. 

 For Japanese, no changes are made either way. 

 For languages where this kind of capitalization changes the meaning, it is best to keep 

this option on. 

Profiles for enrolled users only 

To prevent misuse by spammers, profile descriptions of users who are not yet enrolled in any 

course are hidden. New users must enroll in at least one course before they can add a profile 

description.  

Cron execution via command line only 

Cron is an action that runs various administrative jobs on your Moodle such as sending out 

forum posts. Running the cron from a web browser can expose privileged information to 

anonymous users. Thus it is recommended to only run the cron from the command line or set 

a cron password for remote access.  

Cron password for remote access 

Setting a password will mean that users can only run cron from the browser if they know the 

password and add it like this: 

www.YOURMOODLE.com/admin/cron.php/?password=THEPASSWORDYOUSET.  

Account lockout 

Account lockout may be enabled.  

https://docs.moodle.org/31/en/Cron
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Account lockout threshold: After a specified number of failed login attempts, a user's account 

is locked and they are sent an email containing a URL to unlock the account. Setting this to 

'No' means there is no threshold and an account attempting to log in can do so an unlimited 

number of times.  

Account lockout observation window: Observation time for lockout threshold, if there are no 

failed attempts the threshold counter is reset after this time. This is the counter for how long 

to watch for more failed attempts by an account trying to log in even after being locked out, 

the counter will reset at each attempt and last this long.  

Account lockout duration: Locked out account is automatically unlocked after this duration.  

The account may also be unlocked by an administrator in Administration > Site administration 

> Users > Accounts > Browse list of users or by waiting for the account lockout duration to 

elapse.  

Password policy 

It is highly recommended that a password policy is set to force users to use stronger passwords 

that are less susceptible to being cracked by a intruder.  

 

Password policy 

 

The password policy includes option to set the minimum length of the password, the minimum 

number of digits, the minimum number of lower-case characters, the minimum number of 

upper-case characters and the minimum number of non alphanumeric characters.  
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The password policy is enabled by default. Default (recommended) settings are:  

 Password length - 8 

 Digits - 1 

 Lowercase letters - 1 

 Uppercase letters - 1 

 Non-alphanumeric characters - 1 

If a user enters a password that does not meet the requirements, they are given an error 

message indicating the nature of the problem with the entered password.  

Enabling the password policy does not affect existing users until they decide to or are required 

to change their password. An admin can force all users to change their password using the 

force password change option in Bulk user actions.  

Tip: The password policy may also be applied to enrolment keys by ticking the 'Use password 

policy' checkbox in the Self enrolment settings. 

 

Password rotation limit 

Here you can specify how often a user must change their password before they can re-use a 

previous password. This might not work with some external authentication plugins.  

Log out after password change 

By default, users can change their password and remain logged in. Enabling this setting will 

log them out of existing sessions except the one in which they specify their new password. 

This setting only applies to users manually changing their password, not to bulk password 

changes.  

Group enrolment key policy 

If this is enabled then when a teacher sets a group enrolment key, they will have to set a key 

which follows the password policy set above.  

Disable user profile images 

Check/tick this box if you don't want your users to be able to change their profile images.  
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Email change confirmation 

A confirmation step is required for users to change their email address unless the 

emailchangeconfirmation box is unchecked.  

Remember username 

If you want usernames to be stored during login then set this to "yes". This will store 

permanent cookies and in some countries may be considered a privacy issue if used without 

consent.  

From a UK point of view, see 

http://tracker.moodle.org/secure/attachment/24290/UK+Laws+Relating+to+Cookies-

LUNS2011.pdf  

See also the Using Moodle forum discussion EU Cookie Law.  

 

Strict validation of required fields 

If enabled, users are prevented from entering a space or line break only in required fields in 

forms.  

 

 

 

 

 

 

 

 

http://tracker.moodle.org/secure/attachment/24290/UK+Laws+Relating+to+Cookies-LUNS2011.pdf
http://tracker.moodle.org/secure/attachment/24290/UK+Laws+Relating+to+Cookies-LUNS2011.pdf
http://moodle.org/mod/forum/discuss.php?d=201558
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5. Dissemination of the EXTRO SKILLS digital training Platform  
 

Dissemination of the EXTRO SKILLS digital training Platform will be done according to the 

general dissemination strategy and our EXTRO SKILLS dissemination and communication plan. 

Several communication channels will be used such as internet communication (newsletter, 

RSS), events and meetings, networks and publications.  
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Conclusions  
 

Within the Feasibility Study for the development of the EXTRO SKILLS digital training platform 

we made an analysis and evaluation of (1) how it is best technically feasible, (2) what the best 

outcome within the estimated cost can be and (3) how to ensure its viability through 

exploitation.  

After analyzing the main findings from the national survey that took place before and gave us 

concrete outputs that used for the selection of the best technical solution we overview the 

available technological software solutions and we decided to choose Moodle for the 

development of our EXTRO SKILLS digital training platform.  

At this end, we represent the Moodle technology and the main features and modules of our 

under development EXTRO SKILLS digital training platform.  

We conclude to this solution because Moodle is a learning platform designed to provide 

educators, administrators and learners with a single robust, secure and integrated system to 

create personalized learning environments.  

Conditions for the success of the training platform have also been clearly defined. These 

address the need for continuous evaluation procedures to ensure the identification of any 

educational or technical obstacles; the needs of trainees; trainers and the training institution. 

Additionally, the platform required, in addition to recommendations concerning which type 

of equipment to use were identified in the Technical evaluation. 

A particular condition to ensure the success of this project, is the strong recommendation that 

participants (mentors, trainers and trainees) should be trained in the use of videoconferencing 

prior to the operational phase. The project management have provisionally identified suitable 

material for this purpose. 

Given the above factors, and considering that the costs involved are within the budget 

allocation, it is recommended that the EXTRO SKILLS project consortium continues to invest 

in the project and commences EXTRO SKILLS digital training platform Intellectual Output. 
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ANNEX I 

           

ExtroSkills Questionnaire: 

           

 Purpose: to gain information that will shape the ExtroSkills how to export course.   

 please tick the box most relevant       

 Section 1/About your company       

           
1) How big is your business:        

           

 MICRO   SMALL  MEDIUM   LARGE  

 1-9 employees  10 to 49 employees 50-249 employees  250+ employees 

 
  

 
  

 
  

  

  
 

      

           
 How long have you been established:       

           

 start up   0-1 years   1-10 years 10 years + 

           

 

  
 

  
 

  
 

  
 

     

           
 your company:         

           

 RETAIL  APPAREL  TEXTILES  DESIGN  OTHER  

   MANUFACTURER MANUFACTURER     

 

  
 

  
 

  
 

  
 

  
 

      

           

 your company location: your manufacturing location (if different)   

           

 

  
 

  
     

       

           

 Routes to market:         
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 RETAIL   ONLINE/ETAILER  OTHER    

           

 

  
 

  
 

  
  

     

           

 section 2          

 your export history:         

 NEW TO EXPORT  EXPERIENCED      

 (Go straight to section B) (continue to section A onwards)    

 

  
 

  
     

       

           

 
 

         

 How long have you exported?  % of business per yr  Main Market  
A)           

 

  
  

  
 

  
 

     

           

Distribution channels:        

  Agent  Distibrutor   Retail     

           

  

  
 

  
 

  
    

        

           

           
B) Do you know which country(ies) you would like to export to     

 
          

 EUROPE  AMERICA  OTHER OUTSIDE EU  DON'T KNOW  
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Do you know the quantities/values you would like to export: 

 
          

 YES   NO   aprox amount/total yr 1  

           

 

  
 

  
 

  
  

     

           

           

 Section 3           

 WHY IS EXPORT IMPORTANT FOR YOUR COMPANY:      

 

rank from 1-5/1 being not important 5 extremely important 

       

        

           

 Attract more customers/expansion  

  
      

        

 lessen competition          

 seasonal market          

 new business model          

 improve cash flow          

           

 Section 4          

 RATE YOUR KNOWLEDGE:        

     GOOD  BASIC  

NEED 
HELP  

           

 Establishing your USP           

 Legal aspects           
 Market research           

 Branding Issues           

 Trademark Issues           

 Packaging           
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 Labelling rules           

 Promotional Materials           

 Using overseas agents           
 Finding Trading Partners           

 Creating an overseas Sales team           

 Using Chambers of Commerce           

 Using Embassy/High Commision           

 Trade shows           

 Insurance Issues           
 Export Documentation           

 Exchange rates           

 Trading liabilities           

 Pricing           
 Payment Terms           

 Lead Times           

 Distribution Options           

 Transport Options           

 Ways to be paid           

 

intellectual property protection 
          

           

           

 section 5/ General questions        

           

           

 What would you say are the major issues that exporters need to understand:   

           
 

  

   

    
 

   

           
 What would you say are the most challenging aspects of Exporting:    
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 how confident are you at learning on line:      

           

 VERY CONFIDENT  CONFIDENT  NOT CONFIDENT   

           

 

  
 

  
 

  
  

     

           

 ANYTHING YOU WOULD LIKE TO ADD       
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ANNEX II 
Total Results – Aggregation of Data from 117 Questionnaires 

 

 

Establishing 

your USP
Legal aspects

Market 

research
Branding issues

Trademark 

issues
Packaging Labelling rules

Good 52 52 40 40 35 77 64

Basic 24 33 47 51 55 34 36

Need 

help
14 30 17 24 23 4 15

Promotional 

materials

Using overseas 

agents

Finding 

trading 

partners

Creating an 

overseas sales 

team

Using 

Chambers of 

commerce

Using 

Embassy/High 

Commission

Trade shows

Good 53 42 31 17 27 17 62

Basic 42 38 46 31 53 49 39

Need 

help
21 35 38 62 31 47 16

Insurance 

issues
Export documentation

Exchange 

rates
Trading liabilities Pricing

Payment 

terms
Lead times

Good 34 75 72 47 75 77 73

Basic 50 30 35 51 37 33 36

Need 

help
11 11 10 15 4 7 7

Distribution 

options
Transport options

Ways to be 

paid

Intellectual 

property 

protection

Good 53 71 73 36

Basic 47 37 33 44

Need 

help
15 8 11 35


